
Clearing 

2. Pick "Cut" from the Edit menu. 

The selected text will be removed from the screen and the text around it will be 
reformatted if necessary. The deleted text is temporarily stored on an invisible 
Clipboard. 

If you cut a selection of text that contains block markers, the blocks will not be cut. 
Instead, the markers will be repositioned over the first character following the 
selection which was cut. If the selection you cut contains more than a single block 
marker, the blocks will retain their individual identity, but the markers will 
merge into a single marker and be placed over the first character following the 
selection which was cut. To delete these blocks, use the "Unblock" command (see 
Subsection G. Deleting Blocks in Section 4. of Chapter 2. Using IRIS Intermedia). 

1. Select the text you wish to delete. 

See Subsection B. above. 

2. Press the Delete key. 

The selected text will be removed from the screen and will not be saved on the 
Clipboard (and will also not affect the contents of the Clipboard). Choosing the 
"Undo" command from the Edit menu will undo this operation. 

D. Copying Text 
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Sometimes you may want to copy a selection of text to repeat it at a new 
location without first deleting it. 

1. Select the text you wish to copy. 

See Subsection B. above. 

2. Pick ''Copy" from the Edit menu. 

The selected text is placed on the Clipboard but is not removed from the screen. To 
place the copied material elsewhere in the document, see instructions for pasting 
in Subsection E. below. 
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E. Pasting Text 

Once text has been stored on the Clipboard either by cutting or copying, 
it can be pasted at a new location in the same document or in a 
different one. In some situations, such pasting may affect the style of 
the material to be pasted or that of the text into which it is being 
inserted (see Section 3. Formatting an InterWord Document for 
information on using styles). 

1. Follow the steps for cutting or copying text 

See Subsection C. for cutting text and Subsection D. for copying text. The paste 
command will only be available if the Clipboard contains some text or graphics. 

2. Set an Insertion point In the document In which you wish to paste the selection. 

This indicates the location to paste the material stored on the Clipboard. 

3. Pick "Paste" from the Edit menu. 

The contents of the Clipboard will be pasted at the insertion point. This may have 
an effect on the style of either the pasted text or the text into which the addition is 
made (for some examples of this, see Paste in Section 4. of Chapter VII. InterWord 
Reference Guide). 

F. Changing Type Characteristics 

The steps below describe the method for changing the type 
characteristics of portions of text within a paragraph. It is best to use 
styles if you wish to change the type characteristics of one or more 
paragraphs. See Section 3. Formatting an InterWord Document for 
information on using styles. 

1. Select the text you wish to change. 

See Subsection B. above. 
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2. Pull down the Font menu. 

This menu will give you information about type styles, point 
size and type faces, as well as allow you to change any of these 
characteristics of selected text. Check marks appear next to 
certain items in the menu to let you know what characteristics 
are already associated with the text you have selected. 

3. Select the desired type style, point size and/or typeface from this menu. 

Be sure the text you wish to change is still selected. While it is 
selected, you can make as many changes as you wish. If you 
select the "Base Font" option, the selected text will take on the set 
of type characteristics associated with the style of the paragraph 
of which the text is a part (see Section 3. for information about 
styles). 

..l'Base'font 

..l'Ph1in XP 
Bold XB 
lt111ic XI 

1 o point 
..1'12 point 

14 point 
18 point 

..,lfimes 
Heluetlca 

l.t~tt Sid<~~ 

fli~Jh1 <,i1h~s 
C<rn1<ff~ 

full 

G. Finding and Changing Text 

The "Find" command allows you to search for and change any word or 
string of text in an Inter Word document. 

Changing One Occurence at a Time 

1. Choose "Find" from the Edit menu. 

This will bring up a dialog box. 

Find 

Find: I 
'---~~~~~~~~~~~~~~~~~--' 

Chftnge To: 
...._~~~~~~~~~~~~~~~~~~ 

D Whole Word D M11tch C11se D Wr11p Rround 
D Find Backw11rds D Search Selection 

~ [ Change ) ( Change Then Find ) [ Change Rll ) 

2. Fill in the text you would like to find. 

If you only want to find a string of text and not change it, proceed to step 4. 
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3. Press the Tab key and enter replacement text. 

If you would like to change a word or string of words, enter the new text (i.e. what 
you want the old text to be changed to) in the "Change To" field of the dialog. It is 
not necessary to fill in the "Change To" field if you just wish to search for text. 
You may alter any of the other settings as you need them. See Find in Section 4. of 
Chapter VII. lnterWord Reference Guide for more information on these settings. 

4. Cilek the "Find" button at the bottom of the dialog box. 

lnterWord will locate the text you entered in the dialog box, starting the search at 
the insertion point. If you have entered replacement text in the "Change To" field, 
the "Change" and "Change Then Find" buttons will now be active. 

5. If you want to change the hlghllghted, or found text, pick "Change" or "Change Then Find." 

If you clicked on "Change," the text will change according to what you entered in 
the "Change To" box. If you clicked on "Change Then Find," the text will change 
and the next occurance of the text in the "Find" field will be found. If there are no 
more occurances, you will be notified. 

Find 

Find: jmysses 

Ch&ngeTo: ~IG_r_a_n_t ______________________________ ___. 

D Whole Word D Match Case D Wrap Around 

D Find Backwards D Search Selection 

~ jli.ti!H.,j ( Change Then Find ) ( Change All ) 

6. Click on the Close Box to close the dialog box. 

This step is optional. You may leave the Find dialog open as long as you wish. If it 
gets buried under other windows, pick "Find ... " from the Edit menu. 

Changing All Occurrences at Once 

1. Select "Find" from the Edit menu. 

This will bring up a dialog box. If you only wish to find and change text in a 
portion of your document, select that portion before picking "Find" from the menu. 

2. Fill In the text you would like to change throughout the whole document or in the current selection. 

Typing will replace any text already in the "Find" field. 
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3. Enter the new text (i.e. what you want the old text to be changed to) In the "Change To" field of the dialog 
box. 

The Tab key can be used to advance to the "Change To" field. You may also alter 
the other settings of the dialog box as you need them. For example, you may want 
to set "Search Selection" so that the changes occur only in the current selection 
and not throughout the entire document. To change any of the settings, click once 
in the adjacent box. An "X" will appear to indicate that the setting is in effect. 
Clicking in the box a second time will turn the setting off. See Find in Section 4. 
of Chapter VII. InterWord Reference Guide for more information on these 
settings. 

4. Cilek the "Change All" button at the bottom of the dialog box. 

All occurences of the text in the "Find" field will be changed to whatever you 
entered in the "Change To" field. The search always begins at the insertion point 
and continues to the end of the document. 

Find 

Find: I Ulysses 

Change To: ~jG_r_a_n_t ______________________________ ___, 

1:8:1 Whole Word D Match Case D Wrap Around 

D Find Backwards D Search Selection 

8 ( Change ) ( Change Then Find ) 

5. Ciiek on the Close Box to dose the dialog box. 

Change Rll 

This step is optional. You may leave the Find dialog open as long as you wish. If it 
gets buried under other windows, pick "Find ... " from the Edit menu. 

Editing Text 3. Using lnterWord 



3. FORMATTING AN INTERWORD DOCUMENT 

InterWord documents are made up of paragraphs -· any amount of 
text between two carriage returns - and different styles can be applied 
to each paragraph to change its appearance. Styles are defined and 
edpited using the Font menu and the Ruler. The Font menu allows you 
to change the type face, point size and type style of text. The Ruler, 
which is displayed in the Top Palette of the InterWord window, allows 
you to change settings for margins, tabs, line spacing, and 
justification. You can give each style you define a mnemonic name 
such as "title," "subhead," or "list" so that it is easy to distinguish 
between styles. The names of the styles are found in the Style List, 
located in the Left Palette of the InterWord document window. 

When you open a new InterWord document, you will find several 
predefined styles in the Style List. These styles are provided for your 
convenience. If you start typing in the writing area without changing 
styles, all the paragraphs you create will reference the default style 
"Normal." In general, styles are inherited from one paragraph to the 
next. For instance, if you are entering text in a paragraph that refer­
ences the style called "List" and you hit the Return key, the next 
paragraph will automatically be another list item. 

A. Showing and Hiding the Ruler and Style Palette 

If you only plan to read a document and make few or no editing 
changes, you may want to hide the Ruler and Style Palette to unclutter 
the screen. The Ruler and Style Palette can easily be restored to view 
once hidden. New InterWord documents always open with the Ruler 
and Style Palette displayed; however, existing documents may not have 
the Ruler and/or Style Palette visible when they are opened. The state 
of the Ruler and Style Palette is saved when the document is saved. 

1. P!ck "H!de Top Palette" from the Arrange menu. 

When the Ruler is hidden, you can still select text in the writing area and make 
any editing changes that do not involve styles. If you pull down the Arrange 
menu, you will notice that the "Hide Top Palette" command now says "Show Top 
Palette." This indicates that the Ruler has been hidden. 

2. Pick "Hide Left Palette" from the Arrange menu. 

The Style Palette will be hidden. 
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When you wish to see the Ruler and/or the Style Palette again: 

3. Pick ''Show Top Palette" from the Arrange menu. 

This will restore the Ruler to the top portion of the window. 

4. Pick "Show Left Palette" from the Arrange menu. 

This will restore the Style Palette to the left portion of the window. 

B. Using the Ruler 

The Ruler allows you to display and alter the format of your text. It 
contains a measurement scale (in inches) which resembles an actual 
ruler, and special markers which are selected or placed on this Ruler 
to modify the appearance of your document. The diagram below shows 
the Ruler with all its components. 

Left Margin Merker Current Style Box 

IC 
I I I 11 I I I 21 ... -... ndentation 

Marker 

f!l@~m1 Nor111al 

Align I 
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butt 
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I Justify button 
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button button 

I 

More button 

I I 31 I I I .41 I I 

I li'J~§0 (More ... ) 

Silgla I 
Spacing 

button 

I 
Dcxmle 

Spacilg 
button 

QielllCI 
•Half 

Spacilg 
button 

I 

Right Ma In Marker r 
51 I I 

6~ 
I J• . .a ... i. .. 

' IIl III [!)@l 

Left tab I I 
Decinal 

well wal tab 
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Paragraph Margins 
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You can set the right and left margins of a paragraph by dragging the margin 
marker to the desired position on the Ruler (See Chapter II. Using IRIS Intermedia 
if you need information on dragging objects). When you adjust the left margin, 
the indentation is also adjusted automatically. 
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Indentation 

Tabs 

To indent the first line of a paragraph, drag the indentation marker to the desired 
position on the Ruler. 

iiD Joyce 

9 I I I ! I I .11 
~ 

I I I l I I ,21 I I I l I I ,31 I I I l I I ·~ I I I I Si I 6i 
•.••..• ! ... •·-J-• ... ! .•. • •. i ... • ... L .. • .. f-.. •···! ... •.-.. -

~~lil•I Mormal I liJ~§0 (More ... ) f!] 13] (!] (2:) 

James Joyce ~ 

All of Joyce's work is intimately related to his life Each casual ~ friendship, incident or fragment of his reading was grist to his 

IOI I c;; C2J 

!!D Joyce 

~ t. ! , 1 l I l 1 ,2! I I l ,31, 
I ! .~ 5 I 6l 

I I I I I I I I I I I I I I I I , ...... ! ... •.-i:-• ... ! ... • ... i: .. • ... t .. • ... i: .. • ... ! ... •.-.... 

15l!Elillll I Normal I liJ~§0 (More ... ) f!] 13] (!] (2:) 

James Joyce Q 

All of Joyce's work is intimately related to his life Each I casual friendship, incident or fragment of his reading was grist to 

K:JI 10 C2J 

There are four types of tab stops in lnterWord: Right Tabs, Left Tabs, Centering 
Tabs, and Decimal Point Tabs. The Left Tab aligns items along their left edges, 
the Right Tab to their right edges, and the Centering Tab to the centers of the 
items. In addition, the Decimal Point Tab allows you to align numbers which 
contain decimal points. 

Note: Only Left Tabs are implemented in this version of IRIS lntermedia. 

I I I I ,
21 , I I I I I ,31 , I I I I I ,.:ll, I I I I I 51 6' 

I I I I I I I I , ........ i .. 

Mormal I lilla§w (More ... ) 

This text is aligned on a left tab stop set at 1 incbl 

To use any of these tab stops, drag them to the desired location on the Ruler. 
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Current Style Box 

Normal 

Line Spacing 
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While you are editing your document, the Current Style Box will indicate 
the style associated with the paragraph containing your insertion point or 
selection. If you wish to redefine this particular style, you must click once 
on the name to highlight it and then change the Ruler settings. If you do 
not click on the name in the Style Box, your formatting changes will only 
affect the current paragraph. This is considered a local style change. You 
may also edit any style whose name is in the Style List by clicking on the 
name in the list. The style you have chosen will then appear highlighted in 
the Current Style Box and you may change the Font menu or Ruler settings 
if desired. All paragraphs associated with the style will be reformatted to 
reflect the change. 

The Normal style (12 point Times font, justified text with one inch 
margins and a half-inch first line indent) is the style upon which all other 
styles are based. All styles are defined by how they differ from the Normal 
style. Therefore, if you make changes to the Normal style definition, all 
other styles change accordingly unless you have overridden them with 
another formatting command. For example, the Title style might be 
Normal style plus boldface and centering. If you edit the Normal style to 
create wider margins, the Title margins will be changed, but Titles will 
remain centered and boldface. Changing the definition of the Normal style 
is a powerful way to make global changes to your document. It's a quick 
way to change both line spacing and margin settings of all styles that 
don't override those settings. 

These boxes let you control the amount of space between lines in a paragraph. 
The first three boxes allow you to change the line spacing from single, to one 
and a half, to double spacing. The right box shows you the number of points 
between lines. It will usually contain an "A" to indicate that the number of 
points between the lines is being automatically calculated based on the size 
of the type and the line spacing you have chosen in one of the first three 
boxes. If you wish your interline spacing to be a point size other than that 
automatically calculated for single, one and a half or double spacing, you 
can select the text in the Line Spacing Box and type in a number of points. Be 
sure to press the Return key after typing the number. 
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"More ... " Button 

(More ... ) Clicking on this button will bring up one of two dialog boxes that allow you to 
change style attributes such as the style name, the spacing before and after a 
paragraph of a particular style, the base style, and the style that should alway 
follow the current style. If the name of a style is selected in the Current Style Box, 
clicking on the More button will display the following dialog: 

Style Name:! .... T_it_l_e __________ __. 

Spacing around style: 

Skip --

Based On: 

(( OK )I 

@] pts. Before 

@] pts. After 

NeHt Style: 

Normal 
Numbered Point 
Spttced 

( Concel ) 

The dialog box allows yyou to change some of the attributes of the named style (the 
"Title" style is shown in the illustration). To change the name of a style, edit the 
text in the "Style Name" field. This will change the name in the document's Style 
List. 

If you would like additional space either before or after all paragraphs of this 
style, you can change the numbers in the "Skip pts. Before" and "Skip pts. After" 
fields. This space will be in addition to interline spacing. 

All styles are, by default, based on the Normal style. If you wish your style to be 
based on a style other than Normal, click on the name of a different style in the 
scrolling "Based On" list. All the Font menu and Ruler settings that you have not 
explicitly changed in the current style definition will automatically change to the 
settings of the new base style rather than those of the Normal style. 

Styles are inherited from one paragraph to the next. If you are using the Indented 
Quote style and press Return, the next paragraph will also be an Indented Quote. 
Sometimes it is convenient to alter this behavior. You might decide that you 
always want Normal paragraphs after Indented Quotes. If this is the case, you can 
change the default next style to a new one by selecting any style name from the 
"Next Style" list. 
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Alignment 
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If the name of a style is not selected in the Current Style box, the settings you 
change in the More dialog will only alter the paragraph containing the insertion 
point or selection. In other words, you are making a local style change (see 
Subsection E. for more information on editing local styles). The dialog box that 
will appear when no style name is selected will look like: 

Since you are not 
editing the definition of 
a named style, the only 
items you are able to 
change are the spacing 
before and after the 
current paragraph(s). 

Spacing around style: 

Skip --

(f OK 

pts. Before 

pts. Rfter 

( Cancel ) 

These four buttons allow you to specify how you would like your text 
aligned with respect to the left and right margins. Clicking the Left Align 
button will align your text to the left side of the page, leaving the right side 
"ragged;" the Right Align button will align your text along the right 
margin; the Center Align button centers your text, while the Justify button 
aligns your paragraphs so that they are flush against both the right and left 
margins. 
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C. Creating New Styles 

Each new InterWord document is supplied with six styles: Flush, 
Heading, Indented Quote, Normal, Numbered Point, and Title. For 
some documents, you may want to create additional styles. Once a new 
style is defined, it can be applied to new paragraphs or to existing 
paragraphs. 

1. Show the Ruler and Style Palette If they are not already 
vlslble by selecting "Show Top Palette" and "Show Left 
Palette" from the Arrange menu. 

The Ruler and Style Palette appear in the 
top and left portions of the current docu­
ment. The Ruler has been explained above. 
The Style Palette consists of the Style List, 
the Style Definition, and two buttons, "New" 
and "Apply." The Style List shows you what 
styles are already available for this docu­
ment, while the Style Definition explains 
what each style is (point size, font, indenta­
tions, etc) .. If you choose "New" when no 
style is selected in the Style List, your new 
style will initially have the same settings 
as "Normal." If you choose "New" when a 
style is selected, your new style will start 
off as a copy of that style, and will be based 
on the selected style. 

2. Click once on the ''New'' button. 

Style list/ 

Style Delintion / 

Flush IO 
Heading 
Indented Quote 

•~"'.-ITII 1r1 

Numbered Point 
Title 

R5 
( New ) ( Apply) 

Font: Times 
Romon 12 Point, 

Justified, Indent: 
First 0.50" 

Please enter 11 new style 

A dialog box will appear, 
asking you to enter a name 
for the new style. 

3. Enter a name for the new style and 
dlck"OK." 

Once a style has been 
named, the name is added to 
the Style List and is high­
lighted in the Current Style 
Box, indicating that you can 
edit the definition of the 
style. 

(( OK JJ ( Cancel ) 

Please enter 11 new style 

K OK n ( Cancel 
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4. Alter the Font menu and Ruler settings to create your new style. 

As you make changes, the information is recorded in the Style Definition. When 
you have finished altering the settings, you can apply the style to a new paragraph 
or to existing text by following the instructions in Subsection F. 

D. Editing Named Styles 
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If a style's name is contained in the Style List, that style may be edited. 
If you make changes to a style, those changes will be refiected in every 
paragraph which uses that style. The changes will only affect the 
current document. 

1. Click on a style name In the Style List or In the Current Style Box. 

The name of the style you wish to edit will now be highlighted in black in both the 
Style List and in the Current Style Box on the Ruler. 

Flush 
Heodlng 
Indented Quote 

( New ) ( Rpply ) 
Font: Times 

Romon 12 Point, 
Justified, Indent: 
First o.so· Right 

2.50", Line 
Spocing: 12 pt 

Joyce 

q 11 21 31 4'· 
... , I I I t I I I 1 I I I l I I I 1 I I I l I I I 1 I I I l I I !~: 

!!l ~.HilEI Ill~§~ 
James Joyce 

y..n of Joyce's work is related to his life. Ee.ch 
casual friendship, incide.nt or fre.gxne:nt of his re.a ding was 
grist to his artistic mill. 

Brlef Biography 
His whole. life s ee.rne.d one long artistic proj ec:t 

and, although. s e.e.xningly disp e.re.te., his oue.vre. is 
re.rnarkably similar in its central the.mes, and there is a 
measured progress of technical pronci.e:ncy. From the 
naturalistic b e.se. of the early Dub liners stories, through. 
"The De.ad," "A Portrait," "Ulysses," and finally 
"Finne.gens Wake.," we can detect an ever-increasing 
exp erime.nt in formal de.sign and a progressive move 
toward myth and symbol. 
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2. Change any of the Font menu or Ruler settings. 

For changing Ruler settings, see Subsection B. above. You will see the effects of 
your formatting changes immediately if any paragraphs which use the style you 
are now editing are visible in the InterWord window. Remember that changing 
the definition of an existing style will reformat all paragraphs which use that 
style. 

flush 
Heading 
Indented Quote 

Numbered Point 
Title 

3. Using lnterWord 

( New ) ( Apply ) 
Font: Times 

Romon 12 Point, 
Justified, Indent: 
First 0.25" Right 

2.50", Line 
Spacing: 24 pt 

Joyce 

~ 1 ~ 1 1 ' I ! 
11 . I I 1 I I •

21 I I I l I 

James Joyce 

~ of Joyce's work is related to his life. Ee.ch casual 

friendship, incident or fragment of his reading was grist to 

his artistic mill. 

Brief Biography 
I 

His whole life seemed one long artistic project and, : 
I 

although. seemingly disparate, his ouevre is remarkably : 
I 

similar in its central themes, and there is a measured : 
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E. Editing Local Styles 

Editing named styles is a powerful way to make global changes to text 
scattered throughout your document; however, there are times when 
you may not want to make these global changes. For example, you may 
want to change a single word or phrase in a paragraph to an italic 
face or you may want to change the line spacing in a single 
"Numbered Point" paragraph from double spacing to single spacing 
because that point takes up two lines instead of just one line like most 
of your other points. Whatever the reason, InterWord allows you to 
make local style changes as well as global ones. 

Local Ruler Changes 

1. Set an insertion point In the paragraph you wish to change. 

Be certain that no named style is highlighted in the Current Style Box. Setting an 
insertion point is sufficient to indicate which paragraph should be affected by the 
Ruler changes. 

2. Alter any of the Ruler settings. 

Use the same techniques as explained in Subsection B. 

Local Font Changes 
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1. Select the text you wish to change. 

Setting an insertion point is not sufficient to indicate the text that should be 
changed. You must select the text, even if you wish to change the font 
characteristics of the entire paragraph. Unlike Ruler changes which always affect 
entire paragraphs, font changes can affect any amount of text. 

2. Pick one or more options from the Font menu. 

You can only change one font characteristic at a time, but as long as the text is 
still selected, you can continue to pick other items from the Font menu. 
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F. Applying Styles 

Once a style is in the Style List, it can be applied to one or more 
paragraphs. Even if a paragraph contains no text, a style can still be 
applied. For example, you may have just entered an indented quote 
and now want to return to the ''Normal" style. To do so, finish typing 
the quote, press the Return key (your new paragraph is represented by 
an insertion point) and apply the "Normal" style. 

Applying Styles to New Paragraphs 

1. Create a new paragraph by pressing the Return key. 

Since carriage returns delimit paragraphs, pressing the Return key allows you to 
create a new paragraph. You will now have an insertion point on a blank line. 

Joyce 
Flush Q 
Heading ·~ I I ' l I I , 11 , I I l I I ,

21 , I I l I I ,
31 I I I l I I ·i: 

Indented Quote , 
Normal [5:)~1!J!B I Normal I llJEJ§~ 
Numbered Point 
Title James Joyce 

I 

All of Joyce's work is related ta his life. Each: 
casual friendship, incident or fragment of his ruding was : 
grist to his artistic mill. : 

I~ ~ 
0 Brief Biography I 

!;==~::==~I His whole life see.med one long artistic project 
( New ) ( Apply ) and, although seemingly disparate, his ouevre is 

Normal + remarkably similar in its central the.mes, and the.re is a 
measured progress of technical proficiency. From the 
naturalistic base of the early Dubliners stories, through 
"The Dead," "A Portrait," "Ulysses," and finally 
"F'Ulll.egans Wake," wt. can detect an evu-incnasing 
expe.riment in formal design and a progressive move 

__ .J ....... \. ·- .J .1 I 

2. Cilek on a style name in the Style Ust 

The name of the style you wish to apply to the new paragraph will now be 
highlighted in black. 
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3. Click on the "Apply" button. 

Your new paragraph now has the formatting characteristics of the style you have 
applied. You may observe that the insertion point has moved slightly to reflect the 
indentation and line spacing in the definition of the style you have just applied. 
Double-clicking on the style name has the same effect as steps 2 and 3. 

~D Joyce 
Flush ~ 

O! ' l ! 21 ! 31 4i I 

Heading I I I ' : ' ; I .............. 1·1 .... ; ... 1 .. .! ..• .:. ... 1 ... .:. .. .: ... .:... I I I I I I I I I I I I I 

llllU:J11nrl •I ltrfl il':l I 

Normal !E~@BI Indented Quote lfil~§0 
Numbered Point 

James Joyce I 
Title I 

I 
I 

All of Joyce's work is related to his life. Each : 
casual friendship, incident or fragment of his reading was : 
grist to his artistic mill. 

I 
0 

Brief Biography 
(New ) ll1iijlJt\ His whole life seemed one long artistic proj ec.t 

Normal + Font: and, although seemingly disparate, his ouevre is 
Heluetico, Indent: remarkably similar in its ce.ntral themes, and there is a 
Left 1.00" Right measured progress of technical proficiency. From the 

1.00" naturalistic base of the early Dubliners stories, through 
"The De.ad," "A Portrait," "Ulysses," and finally 
"Finnegans Wake," we can detec.t an e.ver-inc:re.asing 

K;Ji 

Formatting an lnterWord Document 3. Using lnterWord 



4. Enter text at the insertion point 

The text you type will be formatted according to the definition of the style you have 
just applied. 

;;;o Joyce 
Flush ~ O! , l ! ~ ~ 4: Heading I ! • 1 I I ! I I I • I I I 1 .. • ... i ... o ... t: .... l ... • ... !....: ... 1.-• ... i...... I I I I 

Indented Quote 
Normal !iH~l§&ll I nden t.ed Quo t.e 111151§0 
Numbered Point 

James Joyce I 
Title I 

I 
I 

All of Joyce.' s work is related to his life.. Each 
casual friendship, incident or fragment of his reading was 
grist to his artistic mill. 

In Joyce's "Ulysses," one finds that the 
authorl 

0 tt 
( 

Brief Biography 
New ) ( Rpply) His whole. life. s e.e.me.d one. long artistic proj e.ct 

Indented Quote + and, although s e.e.mingly disparate., his oue.vre. is 
re.ma:rke.bly similar in its central the.mes, and the.re. is a. 
me.asure.d pro gre.s s of te.clmical proficiency. From the. 
naturalistic base. of the. early Dubline.rs stories, through 
"The. De.ad," "A Portrait," "tnysse.s," and finally 
"Finne.gans Wake.," we can de.te.ct an e.ve.r-incre.e.sing : 
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Applying Styles to Existing Paragraphs 

138 

1. Set an insertion poin~ or, if you wish, select one or more paragraphs. 

If you only wish to change the style of a single paragraph, setting an insertion 
point somewhere within the boundaries of the paragraph is sufficient to indicate 
what text you wish to reformat. If you want to change the style of more than one 
paragraph, however, you must select them all. This can be accomplished by 
dragging over the paragraphs until all of the text you wish to alter is highlighted 
in black. 

Heading 
Indented Quote 
Normal 
Numbered Point 
Title 

Joyce 

('\J 11 21 31 ~·' .::i I J I 1 I ! I l I ! 1 l I J I l I I I l 1 I I 1 I I 1 l 1 I I : 

~ I 

l!l~f.3~ =~§~: 
James Joyce 

2. Click on a style name In the Style List 

The name of the style you wish to apply to the selected paragraph or paragraphs 
will now be highlighted in black. 

3. Click on the "Apply" button. 

The paragraph containing the insertion point (or the selected paragraphs) will be 
reformatted to reflect the style that has just been applied. 
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4. LINKS AND BLOCKS IN INTERWORD DOCUMENTS 

The section on "Using IRIS Intermedia" provides a general 
description of blocks and links. If you are unfamiliar with these 
concepts, you may wish to review that section. The description below 
will only explain the manner in which you interact with blocks and 
links in the InterWord application. 

In InterWord, any selection of text, from an insertion point to a whole 
document, may become a block - an anchor for a link. Block markers 
are placed over the first character of the text which makes up the block 
extent. Since several blocks may begin with the same first character, 
the existence of a marker indicates that at least one block exists at that 
location. Each of these blocks may have one or more links associated 
with it. Dialog boxes will help you to differentiate between blocks whose 
extents begin with the same first character and the links associated 
with each block. 

Remember, a web must be open to view, manipulate or create blocks 
and links. 

A. Selecting Block Markers 

Block markers are always placed directly over the first character of the 
block's extent. 

1. Position the pointer with Its point In the marker box and click the mouse button once. 

If the cursor is positioned properly, the marker will be selected (highlighted in 
black) when you click the mouse button. If the cursor is not directly over the 
marker, you will set an insertion point rather than select the marker. If this 
happens, just try again. 

13 
All of J~ce's work is intim11telyrell!ted t;(I 
his life Each casual friendship, incident or 
fragment of his readmg was grist to his 
artistic mill. His whole life see.med one 
long artistic project e.nd, although 

Jl.Jl of ~ce.' s wo:rk is intimately relati;.d to 
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B. Creating New Blocks 
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To create a new block in the InterWord application, select the text you 
would like to serve as the anchor for the block. 

1. Select the text you wish to use as the extent for the block. 

An insertion point is also a valid block extent. 

=o Joyce 

James Joyce Q 

E€~?.;t;l~;~;s ~ I 
long artistic project and, although 0 
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2. Choose "Create Block" from the lntermedia menu. 

A block marker will be placed above the first 
character of the selection region. Notice that the 
marker is a straight line enclosed in a rectangle. 
This symbol indicates that there are currently no 
links attached to the block. Links may be attached 
at a later date (see Subsection C). 

~O Joyce 
James Joyce 

Links and Blocks in lnterWord Documents 
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C. Starting and Completing Links 

The process of initiating or completing a link in an InterWord 
document is similar to the process of creating a block. 

1. Select any amount of text or an existing block marker. 

The text or the existing block will serve as the source block of the link. 

2. Choose "Start Link" from the lntennedla menu • 

If you selected text, it will temporarily be considered the source block of the link 
which is pending. 

3. Select another marker or create another selection region In the same or In a different document 

This will be the destination block of the link. 

4. Choose "Complete Link" from the lntennedla menu to finish the link. 

A block marker containing a link symbol will appear above the first character of 
both of the blocks associated with this link if makers were not already there. If 
Link Creation is set to "Verbose" in the Viewing Specifications dialog (see 
Chapter II. Using IRIS Intermedia), then a property sheet will appear so that you 
may name the blocks at both ends of the link (see that chapter for instructions on 
how to use property sheets). 

D. Attaching Links to Existing Blocks 

1. Select an exlsttng marker. 

Click on the block marker. The desired marker should be highlighted in black. 

2. Choose "Start Link" or "Complete Link." 

Use "Start Link" to turn the selected block into the source point for a new link. To 
complete a pending link using an existing block, follow step 1. and then pick 
"Complete Link" to turn the selected block into the destination point for the 
pending link. 
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E. Handling Blocks with Over1apping Extents 
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If two or more blocks have extents which begin with the same character, their markers will overlap. You can still access the links associated with the overlapping markers by interacting with a dialog 
box. 

1. Select a block marker that may represent more than one block. 

All overlapping markers will be selected. 

2. Pick ''Show Block Extent" or "Follow" from the lntermedia menu. 

If more than one block is contained in your selection or if more than one link is attached to a block, a dialog box will appear requesting you to choose the link you wish to follow (see Chapter II. Using IRIS Intermedia). An alternate method of following a link is to double-click on a block marker. 

3. Select the block whose extent you wish to see or the source and destination of the link you wish to follow. 

If you picked "Show Block Extent," the dialog will have a list of blocks, by explainer. If you picked "Follow," the left side of the dialog box contains a list of all blocks (listed by explainer) that are included in your selection. If there is more than one explainer in the "Show Block Extent" dialog or in the source column of the "Follow" dialog, the marker you selected represents more than a single block. The list on the right side of the dialog box shows the destination points of each link associated with the first block. The items in this list indicate the name of the destination document, followed, in parentheses, by the explainer of the destination block. If the "Source" column contains only one item, select the destination to which you wish to travel from the "Destination" column and continue to step 4. If the "Source" column contains more than one item, you can browse through all possible destinations by clicking on each item in the list. Each time you click on a different source block explainer, the list of destinations will change to show you the documents and blocks associated with your choice. Locate and select the destination to which you wish to travel. 

4. Click on the "OK" button. 

The dialog box will disappear and a block extent will be highlighted with a marquee or the document containing the destination block of the selected link will appear. The link marker of the destination block will be selected and the block's extent will be highlighted with a marquee or gray handles, depending on the application at the destination of the link. 
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V. USING INTERDRAW 

InterDraw is a structured graphics editor designed as a tool for creating 
illustrations and diagrams. The editor provides facilities for incorpo­
rating bitmap images - images created using a digitizing camera or a 
paint program - and for overlaying text and graphics on these images. 
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1. HANDLING INTERDRAW DOCUMENTS 

The methods for creating, opening, closing and saving InterDraw 
documents are the same as the methods used for performing these 
operations in other IRIS Intermedia applications. 

A. Opening Existing Graphics Documents 

Existing graphics documents are represented in folder and Web View 
windows by InterDraw document icons. 

1. Select an lnterDraw document icon. 

An InterDraw icon in a folder or Web View window will be highlighted in black. 

:Q······: 
' ' ' . 
:i.:..~ 

Si mp le Cell JL 
Position the pointer Click once 

2. Pick "Open" from the File menu. 

A window containing the InterDraw document will open. Double-clicking on the 
InterDraw document icon will have the same effect as steps 1. and 2. 

B. Opening a New Graphics Document 

You may open a new InterDraw document by using the InterDraw 
icon in the "New" window. 

1. Pick "New" from the File menu. 

The "New" window will open. 
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2. Select the lnterDraw Icon. 

The icon should be highlighted in black. 

~D New 

@ ~ [lg • m . 

Web Folder Val - Word 

3. Choose "Open" from the Fiie menu. 

The InterDraw application will start up, opening a new graphics window. The 
graphics document will initially be called "Untitled." Double-clicking on the 
InterDraw icon in the "New" window will have the same effect as steps 2. and 3. 

C. Saving a Graphics Document 

Once you have made changes to a new or existing graphics document, 
it is a good idea to save your work periodically as a protection against a 
system failure. You may also want to save a copy of the graphics 
document on which you are working. Saving a copy is a useful way to 
back up your work or to freeze a version of the document that you can 
go back to at a later time. 

Saving the Current Document 
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1. Pick "Save" from the Fiie menu. 

The "Save" command will only be available if you have made changes to the 
InterDraw document. Be sure that the window containing the graphics document 
you wish to save is active (the Title Bar should have horizontal black stripes). The 
"Save" command will save all the changes you have made. If you are saving the 
document for the first time, you will be prompted to type in a name for the document. (See illustration of "Save As" dialog box below.) An icon for this 
document will now appear in your current folder. 

Once you save a document, you cannot undo any of the editing changes performed 
before the save. 
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2. Walt for the arrow cursor to return before continuing to work. 

It may take several seconds for the system to save your document. Wait until you 
see the wristwatch turn back into an arrow cursor before trying to edit the 
document. 

Saving a Copy of the Current Document 

1. Pick ''Save As" from the Rle menu. 

Be sure that the window containing the graphics document you wish to save is 
active (the Title Bar should have horizontal black stripes). The "Save As" 
command will bring up a dialog box asking you to type in a name for the copy of 
the current document. 

If you have made changes to your current document since it was last saved, the 
changes will only be saved in the copy of the document and not in the original. 
Save the document before choosing "Save As" if you want the changes saved in 
both versions. 

2. Type in a name tor the copy. 

The name of the document will be selected when the "Save As" dialog appears. 
Type to replace the old name with a new one for the copy of the document. 

Saue this document as: 

( S11Ue cimcel 

Saue this document as: 

I cell backup 

saue Concel 

3. Ciiek on the ''Save" button. 

The "Save As" dialog box will close, a new InterDraw icon with the name just 
entered will appear in your current folder, the original document will close, and 
the copy will replace it in the open Inter Draw window. For example, if you saved a 
copy of the document called "cell" as "cell backup," the "cell backup" document 
will now be open on the screen and the original document, "cell," will have 
closed. 
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D. Closing an lnterDraw Document 
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After you are finished examining or editing a document, it is a good 
idea to save it and put it away. When you close a graphics document, it 
will return to its icon representation. 

1. Pick "Close" from the File menu or click In the window's Close Box. 

Be sure the graphics document you wish to close is in the active window. This 
command will close the window and return the document to its icon 
representation. If you have made changes in the document before closing it, you 
will be asked if you would like to save those changes .. 

Handlina lnterDraw Documents 4. Usina lnterDraw 



2. WORKING WITH THE TOOL PALETIE 

The Inter Draw application contains two types of palettes: a Tool Palette 
and a Style Palette. They are located on the Left Palette and Top Palette, 
respectively. The Tool Palette is used for creating new objects, and the 
Style Palette, which is described in the following section, is used to 
change certain properties (e.g., fill styles, line widths) of the objects 
created using the InterDraw tools. 

The Tool Palette contains icons representing the various types of ob­
jects you can create using InterDraw. For example, there is a Text tool, 
a Line tool, a Rectangle tool, an Oval tool, a Freehand Drawing tool, a 
Polygon" tool, and so forth. To create an object with one of these tools, 
you must first select the tool's icon. Once selected, you can create any 
number of objects of the same type. 

At times you might want to create squares, rounded squares, and cir­
cles rather than rectangles, rounded rectangles, and ovals. To aid with 
this, InterDraw provides a constrained version of a number of the 
tools. See the sections below on particular tools for details. 

To select a tool from the palette, you position the arrow cursor over the 
icon of a tool and click the mouse button once. To select the constrained 
version of a tool, double-click on the icon. Double-clicking on the tool a 
second time will change it back to the unconstrained version. The in­
structions below explain how to use each tool. 

A. Showing and Hiding the Tool and Style Palettes 

If you do not plan to use the Style and I or Tool Palette for a period of 
time, you can hide the Top and Left Palettes from view to unclutter the 
screen. You must hide and show palettes one at a time. 

1. Choose "Hide Top Palette" or "Hide Left Palette" from the Arrange menu. 

The palettes will be removed from the window. 

2. To redisplay, choose "Show Top Palette" or "Show Left Palette" from the Arrange menu. 

The palettes will appear at the top or left of the window. 
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B. Selecting Tools 

C. Text 

152 

When a tool is selected from the palette, you can use that tool indefi­
nitely until you select a different tool. 

1. Position the pointer over a tool icon. 

All tools are selected in the same manner. 

2. Click the mouse button once. 

The tool's icon will now be highlighted in black. When a tool is high­
lighted in black it is selected. The selected tool remains in effect until 
you select a different tool. In order to get the constrained version of the 
tool, double-click on the tool icon. Double-click a second time to return to 
the unconstrained version of the tool. Not all tools have constrained ver­
sions, so double-clicking on these will have no effect. 

A single word or a whole paragraph can be typed into an InterDraw 
document. In addition, any text object can be selected and changed to a 
different type style, point size or type face. Ways to edit the text are ex­
plained in Section 3. Editing Graphics. The constrained version of the 
tool lets you create a bracket to indicate the column width of the text. 

1. Select the Text tool. 

The tool will be highlighted in black. 

2. Position the cursor In the drawing area and 
click the mouse button to create an insertion 
point 

When you release the mouse button, 
there will be a flashing insertion 
point. 

Working with the Tool Palette 
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3. Type In some text Untitled 

Geometric Diagram 

! lj: !i 1 1 •• I •. 

Constrained Text 

In order to get the constrained version of the tool, double-click on the tool icon. 

1. Double-<:lick on the Text tool. 

The tool will change to the constrained Text tool, and will be 
highlighted in black. 

2. In the drawing area, press the mouse button 
and drag the mouse to create a text bracket of 
the desired size. 

When you release the mouse button, 
the bracket will disappear, but there 
will be a flashing insertion point. 

After you type a few words you will 
notice that the text automatically 
wraps around to conform to the width 
of the now invisible bracket. See 
Subsection G. Reshaping Objects of 
Section 3, Editing Graphics for in­
structions on how to change the 
width of the text bracket. 
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D. Lines 
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InterDraw provides facilities for adding lines of various lengths and widths. 

1. Select the Line tool's icon. 

The tool should be highlighted in black. 

2. Move the cursor to the drawing area. Press 
the mouse button and drag. 

The point at which you depressed the 
mouse button will anchor one end 
point of the line. The other end point 
will follow the movements of the 
cursor. This is known as rubber­
banding. 

3. Release the mouse button when the line is in the 
desired position. 

As soon as you release the mouse 
button, the line will become fixed in 
place. 
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Constrained Lines 

The constrained version of this tool lets you draw vertical, horizontal, and 45° an­
gle lines. 

1. In order to get the constrained version of the tool, doublEH:lick on the tool Icon. 

The tool's icon will change to a horizontal line and will be high- [~ 1-1 
lighted in black. -

2. Move the cursor to the drawing area. Press the mouse button and drag. 

The point at which you depressed the mouse button will anchor one end point of the 
line. 

3. Release the mouse button when the line is in the desired position. 

Untitled 

As soon as you release the mouse button, 
the line will become fixed in place. 
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E. Rectangles and Rounded Rectangles 

156 

Two tools exist for creating rectangles. Both are used in the same way, 
but one allows you to create rectangles with rounded corners. 

1. Select the Rectangle or Rounded Rectangle tool's Icon. 

The tool you chose should be highlighted in 
black. These tools work in almost the same 
manner and therefore will be described to­
gether. 

2. Move the cursor to the drawing area. Press 
the mouse button and drag. 

The point at which you pressed the 
mouse button becomes a corner of the 
rectangle or rounded rectangle. 

3. Release the mouse button. 

The rectangle (or rounded rectan­
gle) will be fixed in place. 

Working with the Tool Palette 
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Constrained Rectangles and Rounded Rectangles 

The constrained version of the tool lets you draw squares and rounded squares in 
place of rectangles. 

1. In order to get the constrained version of the tool, doublKlick on the tool Icon. 

The tool's icon will turn into a sqare or ~ ll•ll 
rounded square and will be highlighted in ~ 
black. 

2. Move the cursor to the drawing area Press the mouse button and drag. 

The point at which you pressed the mouse button becomes a corner of the square or 
rounded square . 

3. Release the mouse button. 

The square (or rounded square) will be fixed in place. 

Untitled Untitled 
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F. Ovals 

Ovals are created just like rectangles. Actually, any closed round shape can be created using this tool. 

1. Select the Oval tool's Icon. 

The Oval tool should be highlighted in black. The Oval tool ~ IHI works in almost the same manner as the Rectangle tools. ~ 

2. Move the cursor to the drawing area. Press 
the mouse button and drag. 

The point at which you depressed the 
mouse button becomes a "corner" of 
the oval. 

3. Release the mouse button. 

The oval will be fixed in place. 

Untltled 

Untitled 

Constrained Ovals 
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The constrained version of the tool lets you draw circles in place of ovals. 

1. In order to get the constrained version Of the tool, double-click on the tool Icon. 

The tool's icon will change to a circle and will be highlighted in ~ 11111 black. ~ 

2. Move the cursor to the drawing area. Press the mouse button and drag. 

The point at which you depressed the mouse button becomes a "corner" of the cir­cle. 
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3. Release the mouse button. Untitled 

The circle will be fixed in place. 

q 

G. Arcs 

Arcs are portions of ovals. There is no constrained version of this tool. 

1. Select the Arc tool's Icon. 

The Arc tool should be highlighted in black. 

2. Move the cursor to the drawing area. Press 
the mouse button and drag. 

The point at which you pressed the 
mouse button becomes one end point 
of the arc. 

3. Release the mouse button. 

The arc will be fixed in place. 
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H. Freehand Drawing 

I. Polygons 
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InterDraw allows you to add freehand shapes and designs to your document. There is no constrained version of this tool. 

1. Select the Freehand Drawing tool's Icon. 

The Freehand Drawing tool will be highlighted in black. l~I 

2. Move the cursor to the drawing area. Press untitled 
the mouse button and draw. 

3. Release the mouse button 

Drawing will stop. The shape you have created is considered to be a single object. 

InterDraw allows you to create open or closed polygons. There is no constrained version of this tool. 

1. Select the Polygon tool's Icon 

The Polygon tool will be highlighted in black. 

2. Move the cursor to the drawing area. Ciiek the mouse button to begin the polygon. 

The point at which you click the mouse button will be the first vertex of the poly­gon. 
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Or ... 

3. Drag the mouse and click the mouse button In a 
different location. Repeat to make more vertices. 

Each time you click the mouse but­
ton, a new vertex is created. 

4a Ciiek down In the starting location. 

Closing the polygon indicates 
to InterDraw that you are fin­
ished. 

4b. Double-click on the mouse button. 

InterDraw will automatically 
finish the polygon, giving you 
an open shape. 
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3. EDITING GRAPHICS 

A. Selecting Graphics Objects 

In order to change, copy, cut or alter an existing object, you must first 
select the object. Techniques for selecting objects are detailed below. 

Selecting a Single Object 

1. Select the Arrow tool from the Tool Palette (on the Left Palette). 

The Arrow tool will be highlighted in black. 

2. Position the arrow over an object 

If the object is filled, posi­
tioning the arrow anywhere 
over the object will work. 
(See Subsection H. Using the 
Style Palette for information 
on how to fill objects.) How­
ever, if the object is unfilled 
or a single line, you must be 
sure the arrow is directly 
over a solid black portion. 

3. Click the mouse button once. 

0 

If you have positioned the arrow properly, the object will 
now be selected. A selected object is highlighted with small 
squares called handles. The use of these handles is de­
scribed in Subsection G. Reshaping Objects. 

Selecting Multiple Objects 

1 a. Select one object 

Follow the steps above. 

2a. Hold down the Shift key. 

The Shift key is often used to extend selections. 
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Or ... 

Deselecting 

Or ... 

3a. Select any number of other objects. 

As long as the Shift key is depressed, any objects that are selected will be added to 
the selection. If you select an object that is already selected, it will be subtracted 
from the selection. 

1 b. Position the arrow cursor above and to the left of the objects you wish to select 

Be sure the arrow is not directly on top of an object. You are now going to draw a 
bounding box around more than one object. 

2b. With the mouse button depressed, drag a bounding box around the objects. 

When you press the mouse 
button with the arrow posi­
tioned on an empty space in 
the drawing area and drag 
the mouse, you create a 
bounding box. A bounding 
box is always rectangular. 

3b. Release the mouse button. 

I 
0 

The bounding box will disappear and all the objects en­
tirely inside it will be selected. 

1a. 5eiect another object by ciicking on it or by drawing a new bounding box. 

a 

a 

Selecting another object will deselect any currently selected objects. 

1b. Position the arrow in an empty spot in the drawing area and click the mouse button 

No objects will be selected now. 

- : -

I 
~ 
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Or ... 

1c. If more than one object Is selected, press the Shift key, position the arrow over a selected objec~ and cllck 
the mouse button. 

The object will be subtracted from the selection. As long as the Shift key is held 
down, you can continue to click on selected objects to deselect them. 

B. Deleting Graphics Objects 

Cutting 

Clearing 
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To delete one or more objects from an InterDraw document, you must 
first select them and then either use the "Cut" or the "Clear" com­
mand to remove them. If you cut the objects, they will be temporarily 
stored on the invisible Clipboard so that you can paste them back into a 
different location in the same document or into a different document. 
Clearing the objects does not save them on the Clipboard. 

1. Select one or more object(s). 

Use the techniques described above. Objects are selected when they are surrounded 
by handles. 

2. Choose "Cuf' from the Edit menu. 

The selected object(s) will be deleted and placed on the Clipboard, replacing the 
previous contents of the Clipboard. You are now able to paste this material else­
where in this or another InterDraw document. 

1. Select one or more object(s). 

Use the techniques described above. Objects are selected when they are surrounded 
by handles. 

2. Choose "Clear" from the Edit menu or press t."le Delete key. 

The selected object(s) will be deleted. You will not be able to paste them if they are 
cleared rather than cut. You can, however, choose "Undo" from the Edit menu to 
restore the cleared objects. 
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C. Copying Graphics Objects 

An object or group of objects may be copied and then pasted in the 
same or a different InterDraw document. InterDraw objects stored on 
the Clipboard may also be pasted into any other type of IRIS 
Intermedia document. 

1. Select one or more objects. 

Use one of the techniques described in Subsection A. 

2. Choose "Copy" frOm the Edit menu. 

The display will remain unchanged, but a copy of the selected object(s) will be 
placed on the Clipboard, replacing the previous contents. You are now able to paste 
this material elsewhere in this or another IRIS Intermedia document. 

D. Pasting Graphics Objects 

The last object(s) you deleted by cutting or the last object(s) you copied 
is stored on the Clipboard. Selecting the "Paste" command inserts the 
contents of the Clipboard into your current document. 

1. Ciiek once to set an Insertion point 

This step is optional. Setting an insertion point indicates where you would like the 
object(s) in the Clipboard to be pasted. Unlike some other applications, InterDraw 
does not have a visible insertion point when pasting. Nonetheless, the spot in 
which you click will become the upper left hand corner of the object you are past­
ing. 

2. Choose "Paste" from the Edit menu. 

The contents of the Clipboard will be pasted into your current document whether or 
not it is the same document that the objects were cut or copied from. The object(s) 
can then be repositioned (see Subsection F. Repositioning Objects). 
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E. Editing Text in Graphics Documents 

Adding Text 

166 

Text that has been included in an InterDraw document with the Text 
tool can be edited. You can reformat the text and change its type style, 
point size, typeface or format. These changes are made on all text 
within the selected bracket, so it is suggested that you keep units of text 
small to allow for diverse styles, faces, point sizes, and formats. Addi­
tions and deletions may be made at any place within an existing text 
object. Constrained text objects may be resized by dragging their han­
dles. (see Subsection G. Reshaping Objects). 

1. Select the Text tool Icon 
("t" or ''T") In the Tool 
Palette (on the Left 
Palette). 

You can now insert 
or edit text. The 
technique for edit­
ing text is the same 
for constrained or 
unconstrained text. 
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Deleting Text 

2. Click at some point within existing text or select text you wish to replace by dragging over It 

Clicking once on the mouse button while the pointer is positioned over text will 
create an insertion point. If you wish to replace, cut, or copy text, you should select 
it. Do so by pressing the mouse button and dragging over the characters you wish 
to replace, cut or copy. When all the characters are highlighted in black, release 
the mouse button. 

3. Type to add text. 

Simple Cell 

Endoplasmic !Reticulum 
Cell wall ~ 
Vacuoles 
Lysosome 
Mitochondria 
Nucleuss 
Golqi P,Pparatus 
Olloroplast s 
PLANT CELL 

Simple Cell 

Endoplasmic I @•ttitfl [fHf 
Cell Wall 
Vacuoles 
Lysosome 
Mitochondria 
Nucleuss 
Golqi APParatus 
Olloroplasts 
PLANT CELL 

Anything you type will be added at the insertion point. If you have selected text, 
anything you type will replace that text. You may also paste any text from the 
Clipboard by selecting the "Paste" command from the Edit menu. This text will 
appear at the insertion point or in place of selected text. If any type of object other 
than text is currently stored on the Clipboard, pasting will leave the text in tact 
and add the object from the Clipboard to the document. 

1. Select the Text tool icon in the Tool Palette (on the Left Palette). 

You can now delete or edit text. 
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2. Click at some point within the existing text or select text you wish to replace by dragging over It 

Clicking on the mouse button once while the pointer is positioned over text will 
create an insertion point. If you wish to replace or cut text, you should select it. 

3. Choose "Clear'' from the Edit menu or press the Delete key. 

If you have an insertion point, this will delete the character immediately before 
the insertion point. If you have selected text, pressing the Delete key will delete it. 
You may also choose "Cut" from the Edit menu. This will place the deleted text on 
the invisible Clipboard. If you paste with the Arrow tool selected, a new text object 
will be created, containing the text from the Clipboard. If you paste with the Text 
tool selected, you can insert the contents of the Clipboard within the bounds of any 
other text object. 

Editing Type Style, Point Size, Typeface and Format 

1. With the arrow selected In the Tool Palette, click on a text object to select It 

Brackets will appear with handles. Font and format changes can only be made to 
the entire text object. If you select part of a text object as you would to delete it and 
then choose commands from the Font menu, the changes will be made on the en­
tire text object. 

2. Choose the desired commands from the Font menu. 

Commands in this menu will allow you to change type style, point size, typeface 
and format. 

F. Repositioning Objects 

Once an object has been created, it can be dragged around the drawing 
area and repositioned in another location. Commands in the Arrange 
menu allow you to reposition stacked objects. 

Moving Objects by Dragging 

1. Select one or more objects. 

If multiple objects are selected, they will move "in formation." 

2. Position the arrow cursor over any selected object 

Be sure you are on top of a solid black part of an object. 
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3. Hold down the mouse button and drag the mouse. 

An outline of the object(s) will follow the movement of the mouse. 

4. Release the mouse 
button. 

When you have 
dragged the ob­
jects to a new lo­
cation, releasing 
the mouse button 
will fix them in 
place. 

Repositioning Overlapping Objects 

1. Select an object in the middle of a stack of overlapping objects. 

Handles should appear around the perimeter of this object. 

2. Choose "Move to Front" from the Arrange menu. 

The stack will be redrawn with the selected object on top. 

When you are done with this object and would like to see others in the stack, you 
have two options: sending it to the back or swapping layers. If you wish to go 
through the objects in order, you can send the top object to the back, but if you would 
like to switch an object's position with that of another object in the stack, you can 
swap layers. These two functions are explained immediately below. 

3a. Select an object in a stack. 

This should be one you wish to place on the bottom of the stack. Handles should 
appear around its perimeter. 
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Or ... 

4a Choose ''Send To Back" from the Arrange menu. 

The stack will be redrawn with the selected object on the bottom. 

3b. Select two objects In a stack. 

These should be objects whose positions you wish to switch in the stack. Handles 
should appear around both of the selected objects. 

4b. Choose "Swap Layer" from the Arrange menu. 

The stack will be redrawn with the selected objects in reversed positions. 

G. Reshaping Objects 
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The handles that are used to highlight selected objects are also pro­
vided as a means for reshaping objects. The handles in the corners 
stretch the object in two directions while the handles in the middle 
only stretch the object in one direction. 

1. Select an object 

You can reshape as many objects as you have selected at one time, but it is best to 
experiment with one first. 
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2. Position the arrow cursor directly over a handle. 

I . ... Be sure the tip of the arrow is directly over one of the handles. 

3a. With the mouse button depressed, drag the mouse to enlarge the object 

If you have grabbed a middle handle on the top or bottom, you can enlarge the ob­
ject by dragging either up or down. If you have grabbed a middle handle on the 
right or left, you can enlarge the object by dragging either right or left. If you have 
grabbed a corner handle, you can enlarge the object by dragging both down and 
right, down and left, etc. For example: 

Note: Unconstrained text objects 
cannot be resized. 

3b. With the mouse button depressed, drag the mouse to shrink the object 

The middle handles will allow 
you to shrink the object in one 
direction at a time while the 
corner handles will allow you to 
shrink it in two directions at a 
time. For example: 

4. Release the mouse button when the object reaches the desired size. 

:i I~ J.tt 

Releasing the mouse button will fix the object in its new position and leave it se­
lected. You can now reshape it in a different direction by dragging a different 
handle. 
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H. Using the Style Palette 

The Style Palette, which is used to indicate what properties an object 
should have, provides icons representing different patterns, line 
widths and arrowheads. It is found on the Top Palette. The Style 
Palette is provided so that you can change the style or width of any 
lines, change the fill style of objects, or change the background of any 
text. In addition, it allows you to add arrowheads to lines or arcs. 

Current [BJ ~ Ill Line Widths Rrrowheads Settings 

Fill TeKt Bnckground Line vii! a 
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Pntterns • a 

• llJB 

Changing Fill Patterns 
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1. Select one or more objects. 

These can include any objects that are not created by using the Line or Text tools. 
(Lines and text in the selection will not be changed in any way.) 

For example, if you create a rectangle by us­
ing the Line tool to make the four sides, you 
will not be able to select this rectangle as an 
object. (Selecting the four lines will not work 
for fill style purposes.) If you use the Rectan­
gle or Polygon tool to create the rectangle, 
however, you will be able to select it for this 
purpose. Use the Shift key or a bounding box to 
extend the selection to more than one object if 
desired. 

Editing Graphics 

Current 
Settings 

Ru11il11ble 
Patterns 

Rnim11I Cell 

Fiii TeHt Background Line 

Centriole 
Nucleus 

ANIMAL CELL I 

4. Using lnterDraw 



2. Ciiek on the "Fill" box In the Style Palette If It does not 
have a bold outtine. 

It should turn to a bold outline when selected. 
New InterDraw documents initially open with 
the "Fill" box selected. If you have not been 
changing text backgrounds or line patterns, it 
is not necessary to perform this step. 

iO 
Current 
Settings 

Auailable 
Patterns 

G;l 
Fill 

Animal Cell 

[BJ 
TeHI Background 

Centriole 
Nucleus 

ANIMAL CELL 
., .. , ... ,.,, ........ ,,,,,.,,,.,,,,,,, , .. ., ..... , ... , ... , ... ,,,,,, ...•. ,.,., .. !i, .. ,., ....... . 
,..,,,_,,,,,,,,,,.,.,,,,,,,,,,,.,,,,,,,,,,, ... ,,,,:,;,:,::":''i'i'i•i•!·'i"i:•::·:,:.:.,.,,,,, ...••.. 

3. Click on one of the "Available Patterns." 

If you don't see a pattern you like, use the 
Scroll Arrows to scroll through all the avail­
able patterns. The one you choose will be re­
flected in the "Fill" box, and all the selected 
objects will change to reflect the new fill pat­
tern. To return to the original unfilled pat­
tern, click on the box containing the "N" in 
the upper left hand corner of the "Available 
Patterns." 

Changing Text Background Patterns 

1. Select one or more text objects. 

m 
Current 
Settings 

Auailable 
Patterns 

• Fill 

Animal Cell 

[BJ 
TeHI Background 

Centriole 
Nucleus 

ANIMALCEL~ 

Use the Shift key or a bounding box to select more than one text object. 

2. Click on the ''Text Background" box In the Style Palette. 

It should turn to a bold outline when selected. 
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3. Ciiek on one of the "Available Patterns." 

If you don't see a pattern you like, scroll 
through all the "Available Patterns." 
The one you choose will appear in the 
"Text Background" box and all the 
selected text objects will change to 
reflect the new background pattern. To 
return to the original unfilled back­
ground, click on the box containing the 
"N" in the upper left hand corner of the 
"Available Patterns." 
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1. Select one or more objects composed of lines. 

These can include any non-text objects. Use the Shift key or a bounding box to se­
lect more than one object if desired. 

2. Cilek on the "Une" box In the Style Palette. 
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It should turn to a bold outline when selected. 
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3. Click on one of the "Available Patterns." 

If you don't see a pattern you like, use the 
Scroll Arrows to scroll through all the 
"Available Patterns." The one you choose 
will be reflected in the "Line" box and all 
the lines in the selected objects will change 
to reflect the new line pattern. The fill style 
will not be altered. To return to the original 
solid black pattern, click on the box 
containing the black color chip in the 'lower 
left hand corner of the "Available 
Patterns." 

Changing Line Widths 

1. Select one or more objects 
canposed of lines. Current 

Settings • 

§0 
Current • Settings 

Fill 
Auailable 
Patterns 

Animal Cell 

D ii 
Fill TeHI Background line 

These can include any 
non-text objects. 

2. Click on one of the lines in the 
"Une Widths" column in the Style 
Palette. 

The one you choose will 
be indicated by a check 
mark a.'ld all the lines in 
the selected objects will be 
redisplayed to reflect the 
change. 
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Adding Arrowheads 
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1. Select one or more lines or arcs. 

Arrowheads can only be added to lines created using the Line or Arc tools. Use the 
Shift key or a bounding box to select more than one object if desired. Selected lines 
and arcs have two handles, one at either endpoint. One of these will be solid and 
the other hollow. This differentiation helps you to determine the endpoint of the 
line or arc which will change to an arrowhead. 

2. Click on one of the settings in the "Arrowheads" column In the Style Palette. 

The one you choose will be indicated by a check mark. The first setting (topmost) 
indicates a line without arrowheads. This is the initial setting for all new Inter­Draw documents. To remove arrowheads, simply select the lines with arrowheads 
in your document and click on the no arrowhead setting in the Style Palette. Use 
the second setting to add an arrowhead to the endpoint of the line or arc with the 
hollow handle and the third setting to add the arrowhead to the endpoint with the 
solid handle. The bottom setting will add arrowheads to both endpoints of lines 
and arcs in the selection. 
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I. Aligning Objects 

InterDraw provides powerful facilities for aligning objects. The 
alignment tools allow you to center objects,· line up their tops or bot­
toms or their right or left sides. 

1. Select at least two objects. 

You must have at least two objects selected to use any of the alignment commands. 

2. Choose one of the last six COlllTlands from the Arrange menu. 

1~ 
Original Left Sides Righi Sides 

Horizontl'll Centers Vertic;;il C•nters Horizontal and V•rticOll C•nters 

I 
Bottoms Tops Lett Sides ilnd Bottoms 

Depending on which command you have chosen, the selected objects will now be 
aligned appropriately. The diagram to the right shows the result of each of the dif­
ferent alignment commands. It is often useful to use more than one alignment 
command on a set of selected objects. See the illustration of aligning both Left 
Sides and Bottoms, for example. 
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J. Grouping Objects 

Grouping objects is useful for moving more than one object at a time 
and also for style editing and alignment purposes. When objects are 
grouped together, they behave as if they were a single object. 

Creating a Group 
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1. Select at least two objects. 

These should be the objects you wish to group. 

2. Choose "Group" from the Arrange menu. 

The selected objects will become a group and their individual handles will be re­
placed by a single set that encompasses the entire group. Once you have created a 
group, it will function as a single object. You can build group upon group, if you 
wish, by selecting at least one group as well as other groups and/or objects and 
then choosing the "Group" command from the Arrange menu. 

Two Objects Group 
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1. Select a group. 

Do this either by clicking on any of the objects in the 
group or by drawing a bounding box around the 
group. Wben the group is selected, handles should 
appear around the perimeter of the group. 

2. Choose "Ungroup" from the Arrange menu. 

The objects will remain selected, but will now be 
displayed with handles for each object. If the group 
you originally selected contained one or more groups 
within it, choosing "Ungroup" will only break up the 
largest group. Smaller groups within the selected 
group will remain intact. In this example, the rect­
angle and the circle are still grouped. 

3. Choose "Ungroup" again to break up groups remaining after Step. 2. 

• • 

• 

• 

Remaining groups can be divided into individual objects or smaller groups by 
choosing the "Ungroup" command again. 
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K. Including Pictures Created Outside of lnterDraw 

It can often enhance your illustration to include a bitmap image, such as a digitized photograph. InterDraw provides a facility for including such bitmap images that have been created with the lnterPix appli­cation (see your System Administrator for instructions on how to cre­ate bitmap images). Once the image is copied into the InterDrcw doc­ument, it is considered a single object and can be manipulated in d­most the same way as any other object in the document. 

Copying and Pasting a Bitmap Image from lnterPix to lnterDraw 
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1. Open an existing lnterPlx icon from a folder window. 

You can either double-click on the icon or select it and then choose I~.' I "Open" from the File menu. The window for the InterPix docu-
ment will open. 

2. Press the mouse button above and to the left of the 
area you wish to transfer to an lnterDraw document 

When you drag down and to the right, 
you will create a bounding box. 

3. Drag the mouse until the bounding box encompasses 
the entire area you wish to transfer and then release 
the mouse button. 

Once the bounding box is established, it 
will pulsate. If you wish to remove the 
bounding box and create a new one, 
simply repeat steps 2. and 3. 
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4. Choose "Copy'' from the Edit menu. 

The area within the bounding box will be placed on the invisible Clipboard. 

5. Click in the lnterPlx document's Close Box or choose ''Close" from the Ale menu. 

The InterPix document will close. 

6. Open an lnterDraw document Into which you want to place the copied bitmap picture. 

This can be either a new document or one on which you have previously worked. It 
is also possible to paste bitmap images into other types of IRIS Intermedia 
documents. 

7. Ciiek within the drawing area to set an lnserUon point 

The insertion point will be invisible. 
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8. Choose "Paste" from the Edit menu. 

The copied bitmap picture will appear in the InterDraw document with its upper 
left hand corner positioned at the insertion point. It will appear selected with han­
dles. You can resize and move the picture within the document as you would any 
other object in InterDraw (see Subsections F. and G. above). When resizing, the 
picture will shrink as you drag the different handles. It is not possible to make the picture larger than its original size . 
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Changing the Background of a Bitmap Image 

When first pasted, the background of a bitmap image is transparent. You can 
change the background to opaque (white) if so desired. In the illustration below, the 
bitmap image of the man on the left has an opaque background, while the image 
on the right has a transparent background. 

Notice that not all white areas turn 
transparent. If any white areas are 
completely bounded by black, they 
will remain white even when the 
background is transparent. The spot 
under the man's right arm is a good 
example of white space that you 
might have expected to turn trans­
parent. Since it is bounded entirely 
by a black outline, this space re­
mains white. 

1. Select a bitmap objecl ~D 

Current 
Handles should appear Settings 
around the object. In this 
case, the selected bitmap (eye 
glasses) has an opaque Ru all able 
background. Patterns 
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2. Click on either the "N" or the white 
Icon in the "Available Patterns" portion 
of the Style Palette. 

Be sure the "Fill" box in the 
"Current Settings" row is 
selected with the bold outline. 
The background of the 
bitmap image will change to 
transparent if you select the 
"N" or no fill pattern option, 
and it will change to opaque 
if you select the white fill 
pattern. Selecting any other 
pattern will not affect the 
background of a bitmap im­
age. 

Now the sample bitmap has a 
transparent background. 

Current 
Settings 

Ruallable 
Patterns 

Man with Glasses 

Fill TeHt Background Line 

Notice that the insides of the lenses are transparent, unlike the space under the 
man's right arm in the first example. If you look carefully, you will see that the 
eye glass lenses are not completely solid. The background was able to bleed 
through the small gaps in the bottom of the lenses, as it does in the space between 
the man's legs in the first illustration. 
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4. LINKS AND BLOCKS IN INTERDRAW DOCUMENTS 

Chapter II. Using IRIS Intermedia provides a general description of 
blocks and links. If you are unfamiliar with these concepts, review 
that chapter. The description below will only explain the manner in 
which you interact with blocks and links in the InterDraw application. 

In InterDraw, block markers are initially placed above the upper left 
corner of the the first object selected as the block's extent. Unlike 
markers in most other IRIS Intermedia applications, block markers 
in InterDraw may be repositioned any place with the document. 

Remember, a web must be open to view, manipulate or create blocks 
and links. 

A. Selecting Block Markers 

The method for selecting markers is the same as that for the other 
IRIS Intermedia applications. 

1. Position the cursor over the marker and click the mouse button once. 

The marker should be highlighted in black. 

B. Creating New Blocks 

Blocks are created in InterDraw in the same manner as in other IRIS 
Intermedia applications. You can make blocks of graphic objects, text 
objects, or a combination of both. 

1. Select one or more objects. 

The object(s) should have handles 
once selected. Text objects may be 
selected, but individual words and 
phrases within a text object may not 
be selected apart from the entire ob­
ject. 

4. Using lnterDraw Links and Blocks in Draw 
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If desired ... 

2. Pick "Create Block" from the lntennedla menu. jiiD~~~~~~R~ni~m~a~l~C~e~ll~~~~i!] 

The selected object(s) will be made 
into a block, and a single block 
marker will be placed above the up­
per left corner of the first object you 
selected. 

3. Reposition the block marker. 

ANIMAL CELL 

Block markers are repositioned in the same way as any other object (see Subsec­
tion F. Repositioning Objects). You may drag the marker to any position in the 
current document. 

C. Starting and Completing Links 
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The process of initiating or completing a link in an InterDraw docu­
ment is similar to the process of creating a block. 

1. Select one or more objects. 

The object(s) will serve as the source block of the link. 

2. Choose "Start Link" from the lntennedla menu to Initiate a link. 

The selected object(s) will temporarily be considered the source block of the pend­
ing link. No marker will appear until the block is made permanent by completing 
the link. 

3. Make another selection In the same or In a different document 

This will be the destination block of the link. 

4. Choose ''Complete Link" from the lntermedla menu. 

The source block of the link will be made permanent and markers will be placed 
at the source and destination blocks of the link. 
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D. Attaching Links to Existing Blocks 

A new link may be initiated or terminated anywhere a block already 
exists. 

1. Select an existing marker. 

The desired marker should be highlighted in black. 

2. Choose the ''Start Link" or the "Complete Link" command. 

Use "Start Link" to turn the selected block into the source point for a new link or 
use the "Complete Link" command to turn the selected block into the destination 
point for a pending link. 
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V. USING INTERVAL 

The InterVal application is designed to aid in the creation of timelines. 
Timelines are useful for organizing historic information, or any data, in 
a temporal manner. The application allows you to enter the timeline 
data interactively and then manipulate the display of events in a num­
ber of ways. 
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1. HANDLING INTERVAL DOCUMENTS 

The methods for creating, opening, closing, and saving InterVal documents are the 
same as the methods used for performing these operations in other IRIS 
Intermedia applications. 

A. Opening Existing Timeline Documents 

Existing timeline documents are represented in folder and Web View 
windows by InterVal application icons. 

1. Select an lnterVal document Icon. 

An InterVal icon in a folder window should be highlighted in black. 

~ 
Dickens TL 

Position the pointer Click once 

2. Pick "Open" from the Rle menu. 

A window containing the lnterVal document will open. Double-clicking on the 
icon will achieve the same effect as steps 1. and 2. 

B. Opening a New Timeline Document 

192 

An InterVal icon can be found in the "New" window, allowing you to 
create new timeline documents. 

1. Pick ''NeW'' from the Rle menu. 

The "New" window will open. 
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2. Select 1he lnterVal Icon. 

The icon will be highlighted in black. 

iiO New 

@ ~ • ~ m 
Web folder - Drelo' Word 

3. Choose "Open" from the File menu .. 

The InterVal application will start up, opening a new timeline window. The time­
line document will initially be called "Untitled." Double-clicking on the lnterVal 
icon in the "New" window will accomplish the same effect as steps 2. and 3. 

C. Saving a Timeline Document 

Once you have made changes to a new or existing timeline document, 
it is a good idea to save your work periodically as a protection against a 
system failure. You may also want to save a copy of the timeline doc­
ument you are working on. Saving a copy is a useful way to back up 
your work or to freeze a version of the document that you can go back to 
at a later time. 

Saving the Current Document 

5. Using Interval 

1. Pick "Save" from the File menu. 

The "Save" command will only be available if you have made changes to the In­
terVal document. Be sure that the window containing the timeline you wish to save 
is active (the Title Bar should have horizontal black stripes). The "Save" com­
mand will preserve all the changes you have made. If you are saving the docu­
ment for the first time, you will be prompted to type in a name for the document. 
(See illustration of "Save As" dialog box below.) 

Note: Once you save a document, you cannot undo any of the editing changes per­
formed before the save. 
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2. Wait for the pointer to return before continuing to work. 

It may take several seconds for the system to save your document. Wait until you 
see the wristwatch cursor turn back into an arrrow before trying to edit the docu­
ment. 

Saving a Copy of the Current Document 

194 

1. Pick ''Save As" from the File menu 

Be sure that the window containing the timeline you wish to save is active (the Ti­
tle Bar should have horizontal black stripes). The "Save As" command will bring 
up a dialog box asking you to type in a new name for the copy of the current docu­
ment. 

Note: If you have made changes to your current document since it was last saved, 
the changes will only be saved in the copy of the document and not in the original. 
Save the document before choosing "Save As" if you want the changes saved in 
both versions. 

2. Type In a name for the copy. 

The name of the document will be selected when the "Save As" dialog appears. 
Type to replace the old name with a new one for the copy of the document. 

Saue this document as: 

Seiue Cancel 

Saue this document as: 

I Copy of Dickens Timeline 

Seiue~J Cancel 

3. Click on the "Save" button. 

The "Save As" dialog box will close, a new timeline icon with the name just en­
tered will appear in your current folder, the original document will close and the 
copy will replace it in the open InterVal window. For example, if you were editing 
"Dickens Timeline" and decided to save a copy of it called "Copy of Dickens 
Timeline," the copy would now be open on your screen. 
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D. Closing a Timeline Document 

5. Using Interval 

After you are finished examining or editing a document, it is a good 
idea to save it and put it away. When you close a timeline document, it 
will return to its icon representation. 

1. Pick "Close" from the Rle menu or click In the window's Close Box. 

Be sure the timeline document you wish to close is in the active window. Closing 
the document will close the window and return the document to its icon 
representation. If you have made changes to the document before closing it, you 
will be asked if you would like to save those changes. 
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2. EDITING AND MANIPULATING TIMELINES 

InterVal allows you to view and manipulate timeline data in a num­
ber of ways. You can add and delete events, paste in illustrations from 
InterDraw, and create blocks and links to other IRIS Intermedia 
documents. For example, you might wish to edit a timeline 
chronicling the life of Charles Dickens. You could paste in a portrait of 
Dickens which shows what he looked like the year he published Great 
Expectations, then create a link from this point to an essay on that 
novel. The following pages detail methods for editing and 
manipulating timelines from the display window. 

Arrow Tool 

'~ /ID~ 
Text Tool 

Datt 

Life of Dickens-Title 

1810 Charles born on Feb. 7 to John and Elizabeth Dickens. 

/Pasted graphic from lnterPix 

1820 

'--~~---"'-=--··__, Label 

John Dickens is imprisoned for debt./ 

His family, with the exception of Chilrles, join John in the Manhabea. 

Charles put to work at \ll'arren ·s Blacking Factory. 

1825 Dickens a day pupil at school in London, then an office boy at an attorney's. 

1830 Dickens becomes a free-lance reporter at Doctor's Commons Courts. 

Dickens meets and falls in love with Maria. Beadnell. 

A. Adding Events to a Timeline 
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To create a timeline from scratch or add events to an existing one, use 
the method described below. 

1. Open an existing Interval document or create a new one, 

See Section 1. Handling InterVal Documents for instructions on opening new or 
existing InterVal documents. 
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5. Using Interval 

2. Choose "Add Event .. " from the Edit 
ITBU 

A dialog box will appear, al­
lowing you to enter a date 
and an event. As you enter 
the necessary information in 
the dialog, pressing the Tab 
key will move the cursor to 
the next field. 

3. Type In the desired date and event 
and click on the "OK" button. 

The date should be an integer 
(e.g., 1908). Clicking on the 
"OK" button will close the 
dialog box and display the 
event at the appropriate loca­
tion on the timeline. 

Note: "Add Event" can only 
be used to add textual events. 
You must copy and paste 
graphical events from Inter­
Draw or lnterPix documents. 

Rdd an euent at what year?!._ 1_0_1 _...~"'"'ll-, __ __. 

Label1 

[ OK J) Cancel 

Rdd an euent at what year? I 101 o 
~----~ 

Label? Charles born on feb.7 to Charles and 
Elizabeth Dickens~ 

[ OK ] ( Cancel 

Dickensn 

Llfa of Dickens 

1110 TIJlir1eoDomC111Feb.1 to a+wlii*a. Diollw. I 
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B. Selecting Timelines Objects 

You may choose to select either a title, a marker, or an event (or any 
combination thereof). Each of these is called a timeline object. You may 
also select an entire timeline in order to copy it, change its type style or 
resize the width of the title and event labels. 

Selecting Entire Timelines 

1. Choose "Select All" from the Edit 
mru 

Small black squares called 
handles will appear around 
each object in the timeline 
that can be edited. 

Dickens TL 

"fa of Di~ns • 
18111 

18211 

18215 

18311 

~ 
~ 
1-u !'lmi¥. with the •""81>1ion of ci,;:1e1, join Jalwl ii the Mlrlhlllft. I 
f:hv!es put to worll at waZ,en '1 BladclnQ ""'tcry. I 
l>t<i'ens a d1,f ~ Ii ochool In Lonm;, 1hen 111 otllc:e boy at 111 atiOfney'o. I 
~-become• a free-l111ee reporr Ii Doctor'• Common• COll'to. I 
l>idleno meet. ll1d flll• ~ve with Mlri• Be-.1 

=·~: .. · .: . ..!! ,. !!., .. ,. 

Selecting a Single Timeline Object 
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1. Choose the arrow tool from the tool palette. 

It should be highlighted in black. If the tool Palette is not visible, choose "Show 
Left Palette" from the Arrange menu. 

2. Position the pointer directly over 
the tlmellne object that you wish to se­
lect and click once. 

The object will become se­
lected. Selected timeline ob­
jects are always surrounded 
by handles. 

Dickens Tl 

Ufa of Dick.Ms 

181 o ~ an Feb. 1 to 111<1 au1>ett1 Dlcl<en•. 

1 e20 John Dickens ii lmprl•oned fot -t. 

~ flmlly, with the ... option cf Ch"1eo, join JcM In the M•nllalsea. 

Chlllea pol lo wotk al W&rTen's lllacldn<J Pactcry. 

1825 Dlckeno • d>,V "'°"' at ochcol In Londori, then 111 ol'ftce boy at an aliotney 's. 

1830 Dickens becomes •tree-lance reporter •I Doctor'• Comncn1 Ccurt1. 

Dicken. meets ll1d Ills In love with Moria Bndnel. 

'· 
I' 
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Selecting Multiple Timeline Objects 

The simplest method of selecting consecutive timeline objects is to use the bound­
ing box method explained below. This method, however, does not allow you to se­
lect multiple timeline objects that are not consecutive.To select objects that are not 
consecutive, use the shift-click method instead. 

Bounding Box Method 

1. Position the pointer above and to the left of the object or objects you wish to select 

Be certain that you do not have the pointer positioned over a timeline object. 

2. Press the mouse button and drag 
the mouse so that a bounding box forms 
around the desired object(s). 

More than one consecutive 
timeline object can be se­
lected by extending the 
bounding box to encompass 
all of the objects you wish to 
select. 

3. Release the mouse button when all 
of the desired object(s) are encom­
passed by the bounding box. 

The object or the objects 
completely surrounded by the 
bounding box will become 
selected. 

DlckensTL 

Ufa of Dickens 

1810 a ..... born an Feb. 7 lo John and Elnbelh Dicken•. 

~ 
~ 

1820 JoM Dlckeno Is lmprtsoned for debt. 

tis flmily. with the e>ecepllon or Chorles. Join .JaM In the MvshllseL 

Cllwles put lo work at Wllf'ren"s IMlidcln9 Factory. 

1825 Dlckenl •<Hr~ at sdloal In Londcll. then .. ofllce ~at .. attor!Ml;'"s. 

1830 Olckens Joecome1 l fr- r9l>Qflw 'II Doctor"s Ccmmane C01111. 

Dickens meets IOd hit In love with Mlril. -· 

ril J.i \,, ! . !i 

Dlckensn 

a of Dl!il<ans 

1110 J:hn• born an Feb. 7 to :ev; llld Elnbelh Dicken•. I 

1820 I<*" Dicken• 11 Toned ror -1. I 
1-;i. itrnily. wttil the exception of cil£ries, join JoM in ihe MarshliseL I 
J:hns put to work at w.Z,en's l!lackill;I Faclofy. I 

18215 l51cken1 l Ollf pupil al school In Lanmi. lllen lft ofllce Doy at an •ttomey•s .• 

1130 lllcken• becomes• free-lance reporr at Doctor's Commons Courts. I 
l51cken1 meell >nd 1'1111 ~· wi1h Mwil Be-. I 

~ 

Shift-Click Method 

5. Using Interval 

1. select a timellne object 

Position the pointer over an object and click the mouse button once. The object will 
be surrounded by handles. 
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2. Press and hold down the Shift key 
and select additional objects. 

While pressing the Shift key, 
click on any other timeline 
objects you wish to select. 
Clicking on objects that are 
already selected will remove 
those objects from the selec­
tion. 

3. Release the Shift key. 

Once all the objects you wish 
to edit are selected, you no 
longer need to hold down the 
Shift key. 

Dickens TL 

Ure of Dlckans 

181 O ""'Dorn Oii Feb. 7 tc Ind El!atll Olcl<eno. 

~ 
~ 

1820 John Oldceno II imp11oned fol debt. 

tts flmlly, l>itll tlle eKCoptlon of Cllwle•. Jain .John In the MlrahtlseL 

o..i.. put to work at Wll'ren'• lllacldn9 f'lctory. 

! " 
·I 
i 

i:: 
Ii' 
I I\' , , 

11 
t 

C. Deleting Timeline Objects 

Cutting 

200 

To delete one or more whole events, you must first select them and 
then either use the "Cut" or the "Clear" command to remove them. If 
you cut the objects, they will be temporarily stored on the invisible 
Clipboard so that you can paste them back into the same document or 
into a different document. Clearing the objects does not save them on 
the Clipboard. 

1. Select the Arrow tool from the Tool Palette. 

If the Tool Palette is not visible, choose "Show Left Palette" from the Arrange 
menu. 

2. Select one or more events. 

Use the techniques described 
in Subsection B. Handles 
will aooear around the se­
lected e~ents. 

DlckensTL 
Life of Dicken• 

181 o T Olw""' Dorn "" Feb, 7 to John Ind Elzatll Dick...,. 

~ 
~ 

18 16 DidcenM1 llve ii l till' flu il)i,tholfOOf•ll •ectiOn of London. 

1820 John Dickens imprloonecl for debt. 

tis hmlly, l>ith the IKCeptlon of Cblll'le .. jO;n John In the M.,.h>IML 

Cbiftee Dlckena P"t to wori< ll \llarron 's Blldclng Fu:tory. 
1826 Dickens ad~ pt.,il at Kllool In London, then an o!'llce boy at an attorney 'a. 

1830 Dicken> become> L free-lance repo<lef' at Doclor'I Common1 c .... to . 

. H• 1 .J ,, :: 1, H 
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Clearing 

3. Choose "Cut" from !he Edit menu 

The selected event(s) will be deleted and placed on the Clipboard. You are now able 
to paste this material elsewhere in this or another document. 

Note: If you cut an event that has a block associated with it, the next time you open 
this document the block marker will be placed in the upper left corner of the docu­
ment. To delete a block, use the "Unblock" command (See Subsection G. Deleting 
Blocks in Section 4 of Chapter II Using IRIS lntermedia. 

1. Select one or more events. 

Use the techniques described in Subsection B. Handles will appear around the se­
lected events. 

2. Choose "Clear'' from the Edit menu, or press the Delete key. 

The selected object(s) will be deleted. You will not be able to paste them if they are 
cleared rather than cut. You can choose "Undo" from the Edit menu, however, to 
restore cleared objects. 

D. Copying Timeline Objects 

5. Using lnterVal 

An object or group of objects may be copied and then pasted into the 
same or a different document. 

1. Select the title and/or one or more events. 

Use one of the techniques described in Subsection B. Handles will appear around 
the selected objects. 

2. Choose "Copy" from !he Edit menu. 

The display will remain unchanged, but a copy of the selected object(s) will be 
placed on the Clipboard. You are now able to paste this material into this document 
or a different one. 
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E. Pasting Timeline Objects 
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The last object or group of objects you deleted by cutting or the last ob­
ject or group of objects you copied is stored on the invisible Clipboard. 
You can paste items from the Clipboard into your current document by 
using the "Paste," "Insert Before" and "Insert After" commands in 
the Edit menu. "Paste" performs the same function as an "Insert Af­
ter" when you have an event selected. If no event is selected and the 
object in the Clipboard is not from an InterVal document, "Paste" 
prompts you with a dialog box to give a date for the new event. If the 
date you enter is already on the timeline, your new event is added to 
the end of the events listed at that date. 

Paste euent(s) at what year? 

[ OK 

1. Select an event on the tlmellne. 

Be sure you have the arrow 
tool selected to do this. 

( Cancel ) 

~ DlckensTL 

~ Ufuf ~kans - -

181 o -~"""*""' on Feb. 7 to ..1(¥11 and EIHbeth Dlci<ena. I 

1820 JoM Olckeno lo~ fot -· 

~ flmlly, wlttl the e>ccoptlon Of Clllrles, J<*l .Jotn In the Marshli .. L 

o.artes put to work at warren's~~. 

1112& ~ Olckeno a dl!I' ~at - In L-. lhen 111o1'ftceboyat111 al11ltn8f'•. 

1830 ..... Olckeno - • ,,_ ,_., at Doclcr'• CommoM COlwl1. 

Olckeno meebo Ind fllo In lovewlttl Mll1t. -· 

,,, ! ,, 

I' 

l l 
\ ,. 
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2. Choose "Paste," •insert Before" or "Insert After" from the Edit menu. 

The contents of the Clipboard will be placed either before or after the selected event, 
depending on which command you choose. Again, if you do not specify a date by 
selecting an existing event, InterVal will either prompt you for a year at which to 
place the selection (if the contents of the Clipboard is not from an InterVal docu­
ment), or will place the selection at the same year at which it was located before it 
was cut/copied (if the selection was from InterVal). The rules for pasting text and 
graphics objects are identical. 

Dickens TL 

Life of Dickens 

1810 Cllwleo bom on Feb. 7 lo JoM and Elnbeth Dlckenl. 

l}ile Dlckensu Ive In l tiny flill \11111f'oonoll MCtion of Lendon.I 

~ 
~ 

18ZO John Dickens inprillOMd for debt. 

18Z6 

Ha famiy, IWith the e>0:eption of Chwtes, join Jolvt In the Mwshiloel. 

Cl\-* Dick- put to wmt< ill Wlrr., ·, llodling F..:tory. 

Dlcl<ens a d>f ~ ill Khool In L-. then.., of'!lc:e bof ill t11 illtorne,r·a. 

r 
11 

'i 
:~· 
::·1: 
I 

I' i; 
I· 

I!, 

j' 
; !; 

F. Editing Text in Interval 

The timeline title or any event label can be edited using the text tool. 
Event dates cannot be edited directly; instead, cut the event and paste it 
at the desired date. 

Adding Text to an Existing Event or Title 

5. Using Interval 

1. Select the text too! (the ''T'' !con) from the too! palette. 

The icon will become highlighted in black. If the tool palette is not shown, you can 
display it by choosing "Show Left Palette" from the Arrange menu. 
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2. Ciiek dewn within the b0undar1es of an existing event or tlUe to set an Insertion point where you wish to add text. 

Clicking once on the mouse 
button while the pointer is 
positioned over the text will 
set an insertion point. 

3. Type to add text 

Any typing at an insertion 
point will add text to an event 
or title. 

.. Dlckensn w ur. er Dlckans 

11110 -- Olwiel born an Feb. 7 la Jo'1n Ind El!li>eth Die-. 

lllZO - Jo'1n Olclcenl ~ 
Ho flmlly, wltll the e>U:optlan or Cllwle•. Jolft Jahn In the Mlrsholsea. 

Chortu put towotlc at w.ren·1 81oc1i1n<J ~ 

11121 - Old<olll • dlW pupl •I ......,. In l..Ondan, then an ot'llce boy •t '" attorney'•. 
1830 - DlclleM be<:omoa l ft'ee-llnce r-ter at Doctor's c .......... Cclu1t. 

Dlcken1TL a Uf• or Dickens 

11110 - Chlrle1 born an Feb. 7 to Jahn Ind Ellzli>elll llktcens. 

1820 - Jo'1n Dicken• ~ rar doj 

Ht flmly, will! the e1<coplian or O..le1, jci1 Jo'1n In the M•nhll .. a. 

Chlrlea put to Wor1c at WWren '• lllad<tr'9 Factay 

11121 _,... Cicl<enl ld'W pupil! ldlOolln London, lllenan-e boy It an att~·1. 

1aao _,_ Dlclceno......._ •ft<eeollnoer-1or•t Doctor'• c--. Courts. 

Dlclcen1 meeb and fllb In love wtltl Marla Belllilell. 

:JI .! 1 •.. ! !. i ! !!l'!!l!f[. 1. .. . •.. ill!!!,! .. ! , 1 , . 1 , .• · . !ll!!!l!l ! ! · . !, ! . J!!llL.... 

"' 

Deleting Text from Titles and Events 
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1. Select the text tool ('T' Icon ) from the tool palette. 

The icon will be highlighted in black. You can now delete or edit text. If the tool palette is not shown, you can display it by selecting the "Show Left Palette" com­mand from the Arrange menu. 
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2. Set an Insertion point or select a portion of text 

Position the pointer within 
the boundary of an event or 
title and click the mouse but­
ton to set an insertion point. 
You can select whole words 
by positioning the pointer 
over a word and double­
clicking the mouse. You can 
select any amount of text by 
positioning the pointer before 
the first character you wish to 
select, and pressing and 
holding the mouse button 
down while you drag the 
mouse. When the characters 
you wish to change or delete 
are highlighted, release the 
mouse button. 

Dickens TL 

ure of Dickens 

181 o O..lea klom on Feb. 7 le Jalrund Elzlbeth Dickens. 

~ 
~ 

1820 Jahn Dickens ~ooned far debt. 

1825 

1830 

i'tl ftrnly, - Ille exception al Chartes, Jain Jahn In the M•nhliseL 

Chartes put ta"'""' at \llan'Oft"• l!laclclng l'lclcfy 

Dickens ad~ """at 3Cliaol n London, then 1n amc:e bay at M altarney's. 

Dickens becamet a 1Bmrepartw at Doctor's Cammana Caurts. 
~ 

Dickens meets Md fllls n love 'llllh Mwla Be-. 

3. Pick "Cut" or "Clear" from the Edit menu, press the Delete key, or type new characters. 

In all cases, the selected text 
will disappear. If you set an 
insertion point, cutting or 
clearing will have no effect, 
and pressing the Delete key 
will remove characters to the 
left of the insertion point. If 
you chose "Clear" or pressed 
the Delete key with text se­
lected, the text will be deleted 
and can only be recovered by 
using the "Undo" command 
from the Edit menu. If you 
chose "Cut" with text se­
lected, the text will be stored 
on the Clipboard and may be 
pasted into the current docu­
ment or a different one. 

ID Dickens TL 

~ ure or Dickens 

1810 -~ Cllwlea klom an Feb. 7 le Jahn Ind Elzlbeth Dickens. 

~ 
~ 

1820 ~ Jahn Dlckefls ~far debt. 

i'tl ftrnly, - the exception of Chartes, Jain Jahn In Ille MwshliseL 

Chartes put to"'""' at \llan'Oft't l!laclclng l'lctcry 

1825 .,... Dickens a~""" at 3Cliaol n London, then 1n ot'llce bay at M altarney"s. 

1830 - Dickens Dec:omes o. rr-ojrepaftw at Doctor"• camman. c..na. 

Dicl<eno meets Md hllo ii love llli!h hlwia Be ........ 

G. Repositioning the Title 

You can also move the title anywhere in an InterVal document. 

1. Be sure the Arrow tool is selected. 

The Arrow tool is used for selecting events and moving the title. 
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2. Position the Arrow tool over the title. 

Be sure the pointer is directly over the title. 

3. Press and hold down the mouse but· 01cken1TL 

ton and drag the mouse. it 

The title will follow the 
movement of the mouse. 

4. Release the mouse button. 

1810 Cllwluixlrnon fell. 7to Jolrland Elnl>etn DlckeNo. 

1820 JoM DlcMftl lm!>rl- r ... debt. 

Ha tamly, wtth Ille -!Ion of CllW1, join JcM In the M•nhaloel. 

Dllrles put to worlc al """'"" '• lllll:ldnQ f'lctory 

18211 DlckeNo a dat ,,._.at - In Landan, - an ot'llce tiov at 111 a11 ... ney'1. 

1810 DlckeNo beoor.- l. fl'-• r-1« at Doclor'1 c- C....to. 

- moel1 llld fW in love with hlll'it. lie-. 
i '" l'. t; •! ·, •. '• ,,, "'i •;. '!· 11 :i' 'i i;i' 

;.;! 

• j· 

l ~· 
i I 

When you have dragged the title to a new location, releasing the mouse button will 
fix the title in place. 

H. Reshaping Timeline Textual Events and Titles 
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Handles are used to indicate that an event or title has been selected; in 
addition, they also provide a means for changing the width of text ob­
jects. 

1. Select a title or textual event 

See Subsection B for instructions on selecting timeline objects. 

2. Position the pointer directly over the handle In the mlddle of the right side. 

Be sure the tip of the arrow is squarely in the middle of the handle. Only the mid­
dle handle on the right can be used to resize text objects and only that handle plus 
the bottom middle and right handles can be used to resize graphics objects. If you 
try to use any of the other handles, you will be notified with a dialog box that the 
handle you selected cannot be used to resize the selected object. 
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3. With the mouse button depressed, drag to enlarge or shrink the column width. 

Shrinking and enlarging works the same way it does for text objects in Inter­
Draw. The title or event will be broken up into several lines if the column width is 
small, or will be placed all on one line if the column width is large. Multiple 
timeline events may be resized at the same time by selecting multiple events and 
resizing just one of them. 

1810 Charle:s born on Feb. 7 to John and Elizabeth Dickens. 

e Dickenses &ve in a tiny flat in the 
oorest 3ection of LW1don. 

1820 John Dickens imprisoned for debt. 

His family, with the exception of Charles, join John in the Marshalsea. 

4. Release the mouse button when the colunm width reaches the desired size. 

Releasing the mouse button will fix the object in its new position and leave it se­
lected. 

I. Changing Display Characteristics 

5. Using Interval 

You may change the typeface, point size or type style of any selected 
objects by using commands found in the Font menu. . 

1. Select one or more tlmellne events or a title. 

Hold down the Shift key to select multiple objects or draw a bounding box around 
them. 

2. Choose the desired command from !he Font menu. 

You can change the typeface, point size or type style by choosing the appropriate 
command. To change more than one of these characteristics, simply leave the ob­
ject(s) selected and choose another command from the Font menu. 

Editing and Manipulating Timelines 207 



3. LINKS AND BLOCKS IN INTERVAL DOCUMENTS 

Chapter II, Using IRIS Intermedia provides a general description of blocks and 
links. If you are unfamiliar with these concepts, review that chapter. The 
description below will only explain the manner in which you interact with blocks 
and links in the InterVal application. 

Remember, a web must be open to view, manipulate or create blocks and links. 

A. Selecting Block Markers 
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The method for selecting markers is the same as that for the other 
IRIS Intermedia applications. Note that a web must be open in order to 
perform any of the IRIS Intermedia functions relating to blocks and 
links. 

1. Select the Arrow tool from the Tool Palette (on the Left Palette). 

It should be highlighted in black. 

2. Position the pointer over the marker and click the mouse button once. 

The marker should be highlighted in black. 

Life of Dickens 

1810 - ~rles born on Feb. 7 to John and Elizabeth Dickens. 

The Dickenses live in a. tiny flat in the poorest section of London. 

1820 John Dickens imprisoned for debt. 

His family, with the exception of Charles, join John in the Marshalsea.. 
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B. Creating New Blocks 

Blocks are created in InterVal in the same manner as in other IRIS 
Intermedia applications. 

1. Select at least one event and/or a title. 

Handles will appear around the event(s) and titles. Only events and titles are 
valid block extents. 

2. Pick "Create Block" from the lntermedla menu. 

The selected object(s) will be made into a block, and a block marker will be placed 
above the object that was selected first. 

Life of Dick.ens 

1810 halts born on Feb. 7 to J n and Elizabeth Dickens. 

The Dickenses live in a tiny flat in the poorest section of London. 

1 8 2 O John Dickens imprisoned for debt. 

His family, with the exception of Charles, join John in the Marshalsea.. 

C. Starting and Completing Links 

5. Using Interval 

The process of initiating or completing a link in an InterVal document 
is similar to the process of creating a block. 

1. Select at least one event or title. 

The selection will serve as the source block of the link. 

2. Choose "Start Link" from the lntermedia menu to initiate a link. 

The selection will temporarily be considered the source block of the pending link. 

3. Make another selection In the same or In a different document 

This will be the destination block of the link. 
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4. Choose "Complete Unk" from the lntennedla menu 

The source block of the link will be made permanent and markers will be placed 
at the source and destination blocks of the link. 

D. Attaching Links to Existing Blocks 
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A new link may be initiated or terminated anywhere a block already 
exists. 

1. Select an existing marker. 

The desired marker should be highlighted in black. 

Life of Dickens 

= 
181 O Ct~·les born on Feb. 7 to John and Elizabeth Dickens. 

The Dickenses live in a tiny flat in the poorest section of London. 

1820 John Dickens imprisoned for debt. 

His family, with the exception of Charles, join John in the Marshalsea. 

2. Choose either the''Stan Unk" or the "Complete Unk " command. 

Use "Start Link" to turn the selected block into the source point for a new link or 
use the "Complete Link" command to turn the selected block into the destination 
point for a pending link. 
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VI. IRIS INTERMEDIA REFERENCE GUIDE 

This reference guide contains a description of each menu command 
provided by the IRIS Intermedia system. For a more complete 
description of these commands in the various IRIS Intermedia 
applications, see Chapter VII. InterWord Reference Guide, Chapter 
VIII. InterDraw Reference Guide, and Chapter IX. InterVal Reference 
Guide. 
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1. ti APPLE MENU 

About 
IRISlntennedla... This command opens a dialog box providing release and copyright information 

about IRIS Intermedia. Clicking on the "OK" button or pressing the Return key 
will close the box. 

ExpandWindow Choosing the "Expand Window" command will enlarge the window to either its 
maximum size or to a size that will fit within the boundaries of the screen. 
Choosing "Expand Window" a second time will return the window to its original 
size. This command is particularly useful if a window has been moved so that its 
Scroll Bars and Resize Box are off-screen. In such a case, the "Expand Window" 
command will resize the window so that it is entirely within the boundardies of 
the screen. 

Redraw Screen 

Inter lex 
Dictionary 

Note: Double-clicking on a window's Title Bar is an alternate method of 
expanding or shrinking a window. 

This command redraws the entire IRIS Intermedia screen. Use "Redraw Screen" 
if a message from A/UX or the network has printed on your screen. 

If your site has purchased rights to use the American Heritage Dictionary with 
IRIS Intermedia, you will be able to look up words by using the "InterLex 
Dictionary" reference window. If you do not have a copy of the dictionary, a dialog 
box will inform you that the dictionary can not be found. If you do have the 
dictionary, a dialog box containing a copyright notice will appear (this notice only 
appears the first time you choose the "InterLex Dictionary" command in a 
session). After clicking "OK," you will receive a second dialog box. Type the word 
you wish to look up and press Return. If the word is not found, you will be alerted 
with a dialog box. If the word is found, one or more definition windows will open. 
You may either click in the definition window's Close Box to remove the 
definition from the screen, or pick "Save" from the File menu to save the 
definition as an InterWord document in your current folder. 

In addition to a field for typing a word to look up, the dictionary dialog box also 
contains a Status Line, a Word List and three buttons. After you enter a word and 
press Return, all other dictionary entries containing your -word will be listed. 
This includes all inflections and derivations that have the same root as the word 
you entered. If you click on "List A-Z," the list will expand to show you all the 
entries that are alphabetically adjacent to your word in the dictionary. To return to 
the shorter list, click on "Search Dictionary." To look up any word in the Word 
List, either select the word from the list and choose "Open Definition" or double­
click on the word. More sophisticated searches can be accomplished using 
additional controls (see "Show/Hide Controls" in Section 6. Arrange Menu). In 
addition, you can look up any word that occurs in any document (including 
definition windows) by using the "Define" command (see "Define" in Section 3. 
Edit Menu). 
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2. FILE MENU 

New ... 

Open 

Close 

Close 
Definitions 
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"New ... " opens a window containing icons representing each application 
currently installed in the IRIS Intermedia system and icons representing a web 
and a folder. Selecting an icon and then choosing "Open" from the File menu 
will open a new document, a new web or a new folder. Double-clicking on an icon 
is equivalent to selecting it and then choosing "Open" from the File menu. 

Note: Pressing the Apple key and typing an "n" is an alternate way of opening the 
New window. 

"Open" will open the currently selected icon (web, folder, or document) in a 
folder, Web View, or New window.If the selected icon is already open, choosing 
the "Open" command causes its window to be popped to the top and to be made the 
currently active window. If the selected icon is in the New window, "Open will 
open a document of the type selected. 

Note: Double-clicking on an icon is equivalent to selecting that icon and choosing 
"Open" from the File menu. Pressing the Apple key and typing "o" also has the 
same effect as choosing "Open" from the File menu. 

"Close" causes the active window to 
close and shrink to its icon 
representation. If the contents of a 
document window has changed 
since the document was opened or 
last saved, you will be prompted to 
decide whether or not those changes 
should be saved with this dialog box. 

Saue changes before 
closing? 

n..__v_e_s_,,B ( Cflncel ) ( __ No_~~ 

Note: Clicking on the Close box, located on the left side of window's Title Bar, is 
equivalent to picking the "Close" command from the menu. Pressing the Apple 
key and typing a "w" also has the same effect as choosing "Close" from the File 
menu. 

The "Close Definitions" command is used with the InterLex Dictionary desk 
accessory. If you have opened dictionary definition windows, "Close Definitions" 
will close all open definition windows. 

Note: Pressing the Apple key and typing an "a" has the same effect as choosing 
Close Definitions from the File Menu. 
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Save 

Save As ... 

"Save" will save the contents of the active document window. If the active 
document has not been saved before, the user is prompted with the Save As ... dialog 
box in order to name the document (see "Save As" command for more 
information). 

Note: Pressing the Apple key and typing an "s" has the same effect as choosing 
"Save" from the File Menu. 

"Save As ... " saves a copy of a 
document under a new name. 
You will be prompted to name 
the document with this dialog 
box. 

Saue this document as: 

Saue ) Cancel ) 

Once it is saved under a new name, the original document will be closed and the 
copy will replace it in the open window. A new document icon will be created with 
the new name and placed in the current folder. 

Revert The "Revert" command is not implemented in this version of IRIS Intermedia; 
however, if you wish to revert the document to the state it was in when you last 
saved or opened it, simply close the document and do not save changes. Do this by 
clicking the "No" button in the dialog box illustrated under the "Close" command 
above. 

Delete Document "Delete Document" will delete the selected documents, webs, or folders. For each 
icon you have selected, a dialog box will appear so you may confirm the delete 
operation. If a folder icon is selected, the dialog box will list all items contained 
within the folder. Clicking on the "Delete All" button will remove the folder plus 
all its contents. When the function is completed, the selected icons will disappear. 
There is no way to undo this command. 

Close All 
DocllnentS 

Quit 

If you delete a document with links to other documents, the links emanating from 
the deleted document will be removed as well, although the blocks in the other 
documents will remain intact. If you delete a web,' all links and blocks created 
within the contBxt of that web will also be deleted. 

"Close All Documents" will close all open documents, including the Web View 
window. Open folders are not affected. 

"Quit" will close any open documents, folders, and webs and will end your IRIS 
Intermedia session. Before closing any open documents or webs that are either 
newly created or that have had changes made since they were last saved, IRIS 
Intermedia will present a dialog box asking whether you wish to save changes. 

Note: Pressing the Apple key and typing a "q" is an alternate way of quitting an 
IRIS lntermedia session. 
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3. EDIT MENU 

Undo 

Redo 

Cut 

Copy 

Paste 

216 

When a document is open and active, "Undo" returns the document to the state it 
was in before the last action. "Undo" can be chosen repeatedly until all operations 
since the last time the document was saved have been undone. There are, however, 
operations that cannot be undone, such as "Save," "Save As ... ," "Delete 
Document," "Print" and window manipulations (e.g., scrolling and resizing). 
"Undo" does not affect the contents of the Clipboard. 

Note: Pressing the Apple key and typing a "z" is an alternate way of undoing the 
last action. 

"Redo" reverses the effect of the last undo. Consecutive undos can be redone until 
there are no more commands that can be redone. "Redo" does not affect the 
contents of the Clipboard. 

Note: Pressing the Apple key and typing an "r" is an alternate way of redoing the 
last action. 

"Cut" removes the current selection from the document and places it on the 
Clipboard, thereby replacing any previous contents. Blocks and links are not 
stored on the Clipboard. 

Note: Pressing the Apple key and typing an "x" is an alternate way of cutting 
selected objects or text. 

The "Copy" command copies the current selection onto the Clipboard, thereby 
replacing any previous contents. Blocks and links are not stored on the Clipboard. 

Note: Pressing the Apple key and typing a "c" is an alternate way of copying 
selected objects or text. 

"Paste" places whatever is in the Clipboard into the active document. Each 
application has specific rules regarding pasting; check the chapters Using 
lnterWord, Using InterVal and Using InterDraw for more information. 

Note: Pressing the Apple key and typing a "v" is an alternate way of pasting the 
contents of the Clipboard. 
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Clear 

Find ... 

look Up 

Insert Before 

Insert After 

Duplicate 

Select All 

Add Event 

"Clear" removes the current selection from the active document. It is only 
applicable in some applications. 

The "Find ... " command opens a dialog box which allows you to search for any 
word or string of text in an InterWord document, and allows you to change any or 
all occurrences of that word. 

Find 

Find:[~--------------' 
Chnnge To: 

'--~~~~~~~~~~~~~~~~~~~ 

0 Whole Word 0 Match CHe 
D Find Backwards D Search Selection 

8 ( £ h1rn1.1•~ ) ( £ h1rn~1·~ ·uwn Hnd 

D Wrap Rround 

[ Change All ) 

Note: Pressing the Apple key and typing a "f' is an alternate way of opening the 
Find dialog box. 

This lnterLex command is only available if your site has purchased rights to the 
American Heritage Dictionary. If the dictionary is available, you may select any 
word in an InterWord document or in an InterLex Definition window and choose 
"Define" from the menu. A window containing the dictionary definition will 
open. 

Note: Pressing the Apple key and typing a "d" is an alternate way of looking up 
the definition of a selected word. 

This lnterVal command inserts the contents of the Clipboard before the current 
selection. 

This lnterVal command inserts the contents of the Clipboard after the current 
selection. 

This command duplicates a selection within a document. It is not implemented in 
this version of IRIS Intermedia. 

"Select All" selects all text or graphics objects in a document. 

This InterVal command allows you to add an event to a timeline. 

Note: Pressing the Apple key and typing an "e" is an alternate way of opening the 
Add Event dialog box. 
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4. INTERMEDIA MENU 

Start Link 

Complete Link 

Unlink 

Create Block 

Unblock 

218 

"Start Link" temporarily turns the current selection (which may be a block 
marker) into the source point of a link. If your selection is not a block marker, a 
block will automatically be created when you complete the link. The link is 
pending until you pick "Start Link" again, thereby cancelling the previous "Start 
Link" command, or until you pick "Complete Link" (explained below) to complete 
the pending link. Any number of actions unrelated to creating or completing 
links can occur between a "Start Link" and a "Complete Link" command. A 
pending link is eliminated if you close the current web, close the current 
document or quit the IRIS Intermedia session before completing the link. 

Note: Pressing the Apple key and typing a "(" is an alternate way of starting a 
link. 

"Complete Link" completes a link which is pending from a "Start Link" 
command. A link is created from the source block to the current selection (which 
may be a block marker). 

Note: Pressing the Apple key and typing a "]" is an alternate way of completing a 
link. 

"Unlink" deletes a link. If more than one block is selected, or a block marker 
with more than one link is selected, a dialog box similar to the one below appears 
containing all of the links associated with the selected block(s): 

Please choose the source and then the destination 

Destination 
Core tube sample ITaldn the samplel ~ 
Rille Edge (EUA 3 Station 9) 
Sea of Serenity (landing teHt) 
Twin crater (Crater rim) ~ 

K OK ( Cancel ) 

"Create Block" creates a block consisting of the current selection (minus any 
block markers). A block marker appears near the selection to indicate the 
existence of the block. 

"Unblock" deletes a block associated with the selected block marker. If more than 
one block marker is contained in the selection, a dialog box appears asking you to 
select a block to delete. Only one block can be deleted at a time. Once you have 
chosen the "Unblock" command, the marker will disappear, and the block extent 
will no longer be highlighted (if it was before you chose the "Unblock" command). 
All links attached to the block will also be deleted. 
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ShowBlock 
Extent "Show Block Extent" highlights the extent of one block at a time using either a 

marquee or gray handles. If more than one block is contained in the current 
selection, a dialog box will appear asking you to pick the explainer of the block 
whose extent you wish to view. 

User Properties ... "User Properties ... " allows you to view 
information about the current user. 
Choosing this command brings up a 
dialog box containing the user's name, 
ID, address, phone number(s), and home 
folder. In addition, it is possible to see to 
which access groups the user belongs, and 
which other users are in the same access 
groups. 

User: 
Full Name: 
RddreH: 
Phone 1: 
Phone 2: 
Home: 
Member of 
Groups: 

USER PROPERTIES 

nkm 
Norman Meyrowltz 
212 Darling 
2943 
5554545 
/lrwln/nkm 

other 
project 
scholars 
source 

Docunert 
Properties ... 

Block 
Properties ... 

"Document Properties ... " al­
lows you to view and edit the 
properties of a selected or cur­
rently active document or web. 
Choosing this command brings 
up a dialog box containing the 
access right settings, plus other 
information about the 
document such as the size of 
the document and the name of 
the folder in which it resides. 

Other Group I R 
Members: bl 

'------...1.XJ 

f OK n 

DOCUMENT RCCESS RIGHTS It PROPERTIES 

Protect Write Rnnotate Raad 

1111: D D 181 181 
Group: 181 181 181 181 
Owner: 181 181 181 181 
Inter. 181 181 181 181 

Folder: /Irwin I O/margadocs.CT/Lunar Geology 
Oocument: Moon Silas 
ID: 796 
Type: DRAW 
Owner: klll 
Group: scholan 
Size: 16259 
last Access: Mon Feb 615:18:341989 
Modified: Mon Feb 6 15:18:011989 

( Cancel 

"Block Properties ... " allows you to view or edit the properties of one or more 
blocks. Choosing this command after you have selected one or more block 
markers brings up a dialog box containing the block's property sheet. Creation 
Date and Author are assigned automatically when a block is created. If the 
"Verbose" setting for block creation is in effect in the Viewing Specifications 
dialog box, the "Block Properties ... " command is automatically executed when a 
new block is created as a result of a "Create Block," "Start Link" or "Complete 
Link" command. When the Block Property Sheet is opened for the first time, there 
is a temporary default label in the explainer field which takes the form "Block 
<number>." 
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Picking the "Apply" 
button applies the new 
explainer to the block 
currently selected in 
the block list. Each time 
you edit a block ex­
plainer, you must use 
the "Apply" button be­
fore going on to edit 
another explainer. If 
you only wish to edit a 
single explainer, click 
the "Apply & Close" 
button to apply the 
change and close the 
dialog box. 

BLOCK PROPERTIES 

Blocks 

Alfred J. Worden 
1!-1 I•• 

James B. Irwin 

EHplalner I Oauld A. Scott 

Creation Date: Fri Jan 13 09:57:49 1989 

Ruth or. ny 

( Rpply ) ( Cancel 

Link Properties ... The "Link Properties ... " command opens a Link Property dialog box which allows you to edit the block explainers of the blocks on either end of the selected link. The block explainers listed in the "Source" column represent all the blocks contained in the current selection. When you select a block from the "Source" column, the items listed in the "Destination" column indicate the documents and blocks at the other end of the link. As you select documentlblock pairs from the "Destination" column, the "Source Document," "Source Block," "Destination Document," and "Destination Block," "Author," and "Creation Date" fields will update. You may edit the text in either explainer field. After editing the explainers corresponding to a single link, be sure to click on the "Apply" button before going on to edit any other block explainers. When you are finished editing, use the "Apply & Close" button. If you wish to follow to one of the destinations listed in the "Destination" column, select the destination and click on the "Follow" button. 

LINK PROPERTIES 

Source Document: Rpollo IS Mission Summary 
Source Block: I .. : 
Destination Document: Twin Crater 
Destination Block: ,~~-ra_t_e_r-rl-m------------~ 

Author: ny 
Creation Date: Fri Jan 13 I 0:39:56 I 989 

(Apply & Close J Apply Follow ( Cancel 
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View Specs. •. 

Follow 

"View Specs ... " brings 
up the Viewing Specifi­
cations dialog box with 
the settings that are in 
effect for the current 
web. 

UIEWIN6 SPECIFICRTIONS 

Block Creation: O Uerbose 

Link Creation: ~Uerbose 

(( OK )J ( Cancel 

@Fast 

@Fast 

) 

If the "Fast" setting is specified for either block or link creation, default 
explainers are automatically assigned to all blocks. (See "Block Properties .. .," 
above.) If "Verbose" is set for block creation, a Block Properties dialog box will 
open every time a new block is created. This includes blocks created by a "Start 
Link" or "Complete Link" command. If "Verbose" is set for link creation, a Link 
Properties dialog box will open after each "Complete Link" command. You will be 
able to enter explainers for the blocks at either end of the link. Typically, you will 
either want block or link creation set to "Verbose," but not both. 

Any changes to the settings remain in effect for the current session only. 

"Follow" allows you to travel from the source block to the destination block of any 
link whose marker is currently selected. The document containing the 
destination block opens (or reactivates if it is already open) and scrolls in such a 
way that all or part of the destination block's extent is visible. The destination 
block's marker will be selected, and the extent of the destination block is 
highlighted. 

Pleuse choose the source and then the destination 
Destinflltion 
Core tube ~ample ITakin the ~amplel ~ 
Rille Edge (EUR 3 stB1tion 9) 
Sen of Serenity (landing teHt) 
Twin CrB1ter (CrB1ter rim) ~ 

[ OK ] f Cancel ) 
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It is not possible to follow more than one link at a time. If you select a block marker representing a single link and then choose "Follow," the link is traversed immediately. If, however, you select a marker representing multiple links, a dialog box appears. The left side of the dialog box contains a list of all blocks (listed by explainer) that are included in your selection. One of the blocks is selected. The list on the right side of the dialog box shows the destination points of each link associated with the selected block. The items in this list indicate the name of the destination document, followed, in parentheses, by the explainer of the destination block. If the "Source" column contains only one item, select the destination to which you wish to travel from the "Destination" column. If the "Source" column contains more than one item, you can browse through all possible destinations by clicking on each item in the list of blocks. Each time you click on a different block, the "Destination" list will change to show you the document/block pairs associated with your choice. Locate and select the destination to which you wish to travel. 

Note: Double-clicking on a marker is identical to selecting that marker and choosing "Follow" from the menu. Pressing the Apple key and typing an "f' is another way of following a link. 
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5. FONT MENU 

Base Font 

Plain 

Bold 

Italic 

10, 12, 14, 
18 point 

Times, Helvetica 

Left Sides 

Right Sides 

Centers 

Full 

The "Base Font" command only applies to lnterWord documents. This command 
either changes the entire selection into the base font of the style applied to the 
current paragraph or changes subsequent text typed at the insertion point into the 
base font. 

Choosing "Plain" from the Font menu either changes the entire selection into a 
plain face or causes subsequent text to appear in a plain face. 

Note: Pressing the Apple key and typing a "p" is an altema.te way of doing this. 

Choosing "Bold" from the Font menu either changes the entire selection into a 
bold face or causes subsequent text to appear in a bold face. If the "Bold" command 
appears in the menu with a check mark, picking it will remove the bold face from 
the text. 

Note: Pressing the Apple key and typing a "b" is an alternate way of doing this. 

Choosing "Italic" from the Font menu either changes the entire selection into an 
italic face or causes subsequent text to appear in an italic face. If the "Italic" 
command appears in the menu with a check mark, picking it will remove the 
italic face from the text. 

Note: Pressing the Apple key and typing a "i" is an alternate way of doing this. 

Choosing any point size from the Font menu either changes the selection into the 
selected point size or causes subsequently typed text to appear in that point size. 

Choosing any type style from the Font menu either changes the selection into the 
selected font or causes subsequently typed text to appear in that font. 

This command left justifies selected text objects in InterDraw. 

This command right justifies selected text objects in InterDraw. 

This command centers selected text objects in lnterDraw. 

This command full justifies selected text objects in lnterDraw. 
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6. ARRANGE MENU 

Send to Back 

Move to Front 

Swap Layer 

Group 

Ungroup 

Show/Hide 
Left Palette 

Show/Hide 
Top Palette 

224 

This lnterDraw command moves a selected object in a stack of objects to the 
bottom of the stack. You may select multiple objects to move using this command. 
If you do so, the selected objects will retain their original relationship to one 
another at the bottom of the stack. All of the objects beneath the selected object will 
move up one place in the stack, making this command useful for examining 
items in a stack one by one. 

This InterDraw command moves a selected object in a stack of objects to the top of 
the stack so that it can be easily examined and worked on. You may select 
multiple objects to move using this command. If you do so, the selected objects will 
retain their original relationship to one another at the top of the stack. All of the 
objects originally ahead of the selected object in the stack will move down one. 

This InterDraw command switches the positions of two selected objects in a stack 
of objects. For example, if you choose this command after selecting a rectangle on 
the bottom of the stack and an oval directly under the top object in the stack, the 
rectangle will move up to occupy the oval's position and the oval will go to the 
bottom of the stack. 

If more than one object is selected, the "Group" command in InterDraw groups the 
objects so that they will behave as a single object. Any objects in the selection that 
are already groups are imbedded in the new group so that no grouping 
information is lost. After grouping, the group is then selected (shown with handles 
placed in a rectangular region encompassing all the objects in the group). 

If the selection contains objects that have been grouped, the InterDraw command 
"Ungroup" separates the objects. All of the objects in the group will be individually 
selected (surrounded by handles). Any imbedded groups within the selection 
remain grouped. If you want to ungroup imbedded groups, you must select the 
remaining groups and use the "Ungroup" command again. 

If the Left Palette is visible, you can hide it from view by selecting "Hide Left 
Palette." When the Left Palette is hidden, you can perform some editing 
commands on the document, but you cannot use any of the available tools. 

If the Top Palette is visible, you can hide it from view by selecting "Hide Top 
Palette." When the Top Palette is hidden, you can perform most editing 
commands on the document, but cannot work with any of the available tools. 
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Show/Hide 
Controls This command only applies to the InterLex reference window. If the InterLex 

controls are visible, you can hide them from view by selecting "Hide Controls." 
When the Controls are hidden, you can look up words in the American Heritage 
Dictionary, but you can not alter any of the search criteria. Information about the 
controls can be found in the documentation which accompanies the dictionary. 

Align Left Sides This InterDraw command aligns the left sides of two or more selected objects. The 
object selected first remains in its place, and the others will gravitate to it. 

Align Hor1zontal 
Centers This InterDraw command aligns the horizontal centers of two or more selected 

objects. The horizontal centers of the selected objects are averaged to find the new 
horizontal center for the selection, and the objects will gravitate to it. 

Align Right Sides This InterDraw command aligns the right sides of two or more selected objects. 

Align Tops 

Align 

The object selected first remains in its place, and the others will gravitate to it. 

This lnterDraw command aligns the top sides of two or more selected objects. The 
object selected first remains in its place, and the others will gravitate to it. 

Vertical Centers This Inter Draw command aligns the vertical centers of two or more selected 
objects. The vertical centers of the selected objects are averaged to find the new 
vertical center for selection, and the objects will gravitate to it. 

Align Bottoms This InterDraw command aligns the bottom sides of two or more selected objects. 
The object selected first remains in its place, and the others will gravitate to it. 
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7. PRINT MENU 

Page Setup ... 

Print .. 

Print One 

Headings 

Margins. .. 
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This command brings up a dialog box which asks you to specify the type of paper, orientation of the document, percentage, and special printer effects. 

LaserWriter .,. 1 ===-=-===-=====-======-=====-======-===----"'v•~-·--1 OK II 
Paper: ® US Letter 0 R4 Letter Reduce or UltliU ~ ( Cancel J 0 US Legal O BS Letter Enlarge: 

Orientation 

-~ 
Printer Effects: 
181 Font Substitution? 
181 Smoothing? 

This dialog box asks about number of copies, paper source, cover page, and the pages of the document you want to print. 

LnserWriter <LaserWriter> v!.1 I OK J 
Copies:UMI Pages:® All 0 From:LJo:CJ (Cancel) 
Couer Page: ® No 0 First Page 0 Lnst Page 

Help 
Paper Source: ® Paper Cassette 0 Manual Feed 

"Print One" sends one copy of the current document to the printer, bypassing the Pring dialog box. 

This command brings up a dialog box for heading settings. This command is not implemented in this version of IRIS Intermedia. 

This dialog box asks about the margin settings for the document. 

Set margins to: 

OD" 

OK 

® 1/2" 01" 011/2" 02· 

0 Printable aree of page 

Print Menu 

0 2 1/2" 

cancel 
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Start Page 
Number ... "Start Page Number ... " brings up a dialog box which asks you where page 

numbering should start. 

Stortlng poge number: Ii I 

OK Cancel 

Top to Bottom This command numbers pages top to bottom; deselecting it will change the 
numbering to Side to Side. 

Print Page 
Nunt>ers "Print Page Numbers" adds the page numbers to the printed copy of the document. 

Include Frame This command places a black border around your document when it is printed out. 

Show Breaks This command displays lines to illustrate where page breaks will occur during 
printing. 

Show Page 
Nunt>ers This command shows the page numbers of the document on the screen. 

Show Borders "Show Borders" displays a border around each page of your document. The 
command does not affect printing. 
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VII. INTERWORD REFERENCE GUIDE 

This reference guide contains a description of the Style List buttons and 
each menu command provided by the InterWord application. For 
descriptions of the IRIS Intermedia system menu commands, see the 
Chapter VI. IRIS Intermedia Reference Guide. 
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1. STYLE LIST BUTTONS 

New Clicking on the "New" button in the style palette causes a 
dialog box to appear, asking you for a name for the new 
style. 

Apply Picking the "Apply" button reformats any paragraphs that 
contain the insertion point or all or part of a selection 
according to the definition of the style that is currently 
selected in the Style List. Even if only part of a paragraph 
is selected, the entire paragraph will be reformatted. 
Double-clicking on a style name is equivalent to selecting 
the style name and clicking on the "Apply" button. 

7. lnterWord Reference Guide Style List Buttons 

Flush Q 
Heading 
Indented Quote 

•• . 
Numbered Point 
Title 

0 
( New ) ( Rpply ) 

Font: Times 
Roman 12 Point, 

Justified, Indent: 
First 0.50" 
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2. ti APPLE MENU 

Note: All Apple menu commands behave in the same manner for all IRIS 
Intermedia applications and are not described in this section. For an explanation of 
the "About IRIS Intermedia ... ," "Expand Window," "Redraw Screen," and 
"InterLex Dictionary" commands, see Chapter VI. IRIS Intermedia Reference 
Guide. 
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3. FILE MENU 

Note: File menu commands that behave in the same manner for all IRIS 
Intermedia applications are not described below. For an explanation of the "Open," 
"Close," "Close Definitions," "Save," "Save As ... ," "Revert," "Delete Document," 
"Close All Documents," and "Quit" commands, see Chapter VI. IRIS lntermedia 
Reference Guide. 

New ... Selecting the "New ... " command opens a window containing all the currently 
available IRIS lntermedia tools, including an InterWord application icon. When 
you double-click on the InterWord icon or select "Open" from the File menu, an 
"Untitled" InterWord window opens. A Ruler appears in the Top Palette of the 
window, and the Style Palette is visible in the window's Left Palette. The blank 
central portion of the window, called the writing area, is for text entry. An 
insertion point is positioned on the first line. Typing at the insertion point creates 
a paragraph using the "Normal" style settings for indentation, margins, tabs, 
line spacing, and justification. All text entered in the writing area may be 
scrolled. The InterWord window may be moved and resized like all other IRIS 
lntermedia windows. 

Note: Pressing down the Apple key and typing an 'n' is an alternate method of 
displaying the New window. 
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4. EDIT MENU 

Note: Edit menu commands that behave in the same manner for all IRIS 
Intermedia applications or those that do not apply to InterWord are not described 
in this section. See Chapter VI. IRIS Intermedia Reference Guide for a description 
of the "Undo," "Redo," "Define," "Insert Before," "Insert After," "Duplicate," 
"Select All," and "Add Event" commands. 

Cut 

Copy 

Paste 
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The "Cut" command deletes any text contained in the current selection and places 
it on the Clipboard. If the cut selection contains one or more carriage return 
characters (spans more than one paragraph) and begins in the middle of a 
paragraph, the text between the end of the cut selection and the next paragraph 
becomes part of the paragraph that is now directly above it and is reformatted 
accordingly. If the cut selection contains one or more carriage return characters 
but starts at the beginning of a paragraph, the text between the end of the cut 
selection and the next paragraph will begin a new paragraph but will take on the 
style characteristics of the first paragraph in the selection. When in the Clipboard, 
a carriage return character always maintains its tie to the style it referenced before being cut. 

If block markers are contained in the selection, they will not be cut. They will be repositioned over the first character directly after the selection region. 

Note: Pressing the Apple key and typing an 
selected text. 

It t1 
x is an alternate way of cutting 

The "Copy" command places any selected text on the Clipboard without deleting it 
from the original location. Links are not maintained in the Clipboard. If block 
markers are contained in the selection, they will not be copie 

Note: Pressing the Apple key and typing a "c" is an alternate way of copying text. 

The "Paste" command is only available when text or graphics from InterWord or 
another application has been placed on the Clipboard by cutting or copying. If the 
Clipboard is not empty, the "Paste" command either places the contents of the 
Clipboard at the insertion point or replaces a selection region with the contents of 
the Clipboard. 

If the text in the Clipboard contains one or more carriage return characters, one of 
several things may happen depending on the makeup of the text in the Clipboard. 
Remember that carriage returns maintain their tie to style information when in the Clipboard. Below, the result of a paste operation in two different cases is 
describe In both cases, it is assumed that the paste is being done in the middle of 
an existing paragraph at an insertion point. The result of a paste operation in any 
other case can easily be derived from the cases described in detail below. 

Note: Pressing the Apple key and typing a "v" is an alternate way of pasting text. 
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CASE · 1: Pasting a text string containing no carriage returns. No matter what 
style paragraph the text was originally a part of, the text takes on the 
characteristics of the paragraph into which it is paste 

Joyce 
James Joyce 

All of Joyce's work is related to his 
life. 

Brief Biography 

Select text. 

• ==c Joyce 
James Joyce 

All of Joyce's work is related to his 
life. Ea.ch casual friendship, incident, or 
fra.gxne.nt of his reading wu grist for his 
artistic mill. ~ 

Brief Blof18Phy 
His "Nflole life seemed li/c.eri 
one long artistic project. 
Although they seem quite 
different, /?is li\it7t*s are 

Paste text. 
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Joyce 
James Joyce 

All of Joyce's work is related to his 

life. I~ 

Brief Biog1:'8fhy 
His W/Jole life seemed li/c.eri 
one long attistfc project. 
Although they seem quite 
different, /?is wot*s are 
tematM/Jly s1rmlar in its 

Q 

central t/?eme. There is a o 

Cut selection and set a new insertion point. 
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Clear 

Find .. 
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CASE 2: Pasting a text selection containing at least one carriage return. When 
you paste, any text before the pasting point is unchanged. If you paste within the 
boundaries of an existing paragraph (as illustrated), the text in that paragraph 
after the pasting point is reformatted to conform with the style associated with the 
last carriage return in the Clipboard. 

Joyce 
James Joyce 

life.. 

Select text. 

-0 Joyce 
James Joyce 

I~ 
Brief Biography 

IOI 

His wflole life seemed li/t.ed 
one long attistic project. All of 
Joyce :S IM:Jt* is related to l'lis 
life. Eacl'l casual ttiendsl'lip, 
incident; or fi'agment of l'lis 
reading was gn"st tbr 1'11"s 
attistic mill. Altl'lougl'l t/'Jey 
seem qwte different, l'l1"s 1M:Jt*s 
are remamalJ/y similar in its 

Paste text. 

Joyce 
James Joyce 

IA.ii of Joyce.' s work. is rel.ate.d to his 
life.. ~ch casual frie.ndship, incident, or 
fragme.nt of his re.ading was grist for his 
artistic mill. Although they s e.em quite. 
different, his works are. re.m.arke.bly similar 
in its central the.me.. The.re. is e. me.a.sured 
progress of technical prouci.e:ncy. From the. 
naturalistic b a.se. of the. e.arly Dubline.rs 
stories, through "The. De.ad," u A Portrait," 
"Ul sses • and finall "Fi 

Cut selection and set a new insertion point. 

The "Clear" command in the menu does not apply to InterWord; however, 
pressing the Delete key removes the current selection from the active document. 
The formatting of text is affected in the same manner as when text is cut (see 
Subsection Cut). 

The "Find ... " command displays a dialog box which allows you to search for any 
word or string of text in an InterWord document, and allows you to change any or 
all occurrences of that word. When the dialog box first opens, only the "Find" and 
"Change All" buttons are available. As soon as you find a particular word or 
string, "Change" and "Change Then Find" are enabled. 
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The "Find" dialog box provides five optional settings. If an "x" appears in the box 
adjacent to a setting, the setting is in effect. Clicking once on the box will turn the 
setting on and place an "x" in the box. Clicking a second time will turn the 
setting off, removing the "x" from the box. 

If the "Whole Word" setting is turned on, pressing "Find" will only find the 
exact contents of the text you have entered in the "Find:" field of the dialog box. 
When this setting is off, you may find the text in the "Find:" field even if it is 
part of another word. For example, an "a" in the "Find:" field with the "Whole 
Word" setting turned off will cause any word containing an "a" to be found. If the 
setting is turned on, only the word "a" will be found. 

"Find Backwards" allows you to search from the insertion point back to the 
beginning of the document. Normally, a search occurs from the insertion point to 
the end of the document. 

The "Match Case" setting allows you to specify whether or not you would like the 
"Find" command to pay attention to upper and lower case letters. If "Match Case" 
is not set, you will find all text that matches the text in the "Find:" field 
regardless of capitalization. 

The "Search Selection" setting is particularly useful in conjunction with the 
"Change All" button. It only applies if you created a selection before picking 
"Find ... " from the Edit menu. When turned on, you will only find text or change 
text within the boundaries of the selection. 

The "Wrap Around" setting is most useful when you pick the "Find ... " command 
from the middle of a document. In this case, the find operation will start at your 
insertion point, go to the end of the document and then continue the search at the 
beginning of the document. 

You must click on "Cancel" to leave the "Find" dialog box. 

Note: Pressing the Apple key and typing a "t' is an alternate way of bring up the 
Find dialog box. 
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5. INTERMEDIA MENU 

Note: Intermedia menu commands that behave in the same manner for all IRIS 
Intermedia applications are not described below. For an explanation of the "Start 
Link," "Complete Link," "Unlink," "Create Block," "Unblock," "Show Block Extent," 
"User Properties ... ," "Document Properties ... ," "Block Properties ... ," "Link 
Properties ... ," "View Specs ... " and "Follow" commands, see Chapter VI. IRIS 
I ntermedia Reference Guide. 
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6. FONT MENU 

Note: Font menu commands that behave in the same manner for all IRIS 
Intermedia applications or are not applicable to InterWord are not described below. 
For an explanation of the "Plain," "Bold," "Italic," "10-," "12-," "14-," "18 point," 
"Times," "Helvetica," "Left Sides," "Right Sides," "Centers," and "Full" commands, 
see Chapter VI. IRIS Intermedia Reference Guide. 

Base Font The "Base Font" command returns selected text to the base font of the style applied 
to the paragraph(s) contained in the selection region. The base font of a style 
encompasses the type face, the point size and the type family that is defined for the 
style. 
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7. ARRANGE MENU 

Note: Arrange menu commands primarily apply to Inter Draw documents, so most 
of the commands are not described below. For an explanation of "Send to Back," 
"Move to Front," "Swap Layers," "Group," "Ungroup," "Align Left Sides," "Align 
Horizontal Centers," "Align Right Sides," "Align Tops," "Align Vertical Centers," 
and "Align Bottoms," see Chapter VI. IRIS Intermedia Reference Guide. 

Show/Hide 
Top Palette 

Show/Hide 
Left Palette 
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"Hide Top Palette" hides the InterWord Ruler. Choosing "Show Top Palette" will 
display the Ruler if it is hidden. 

"Hide Left Palette" hides the lnterWord Style Palette. Choosing "Show Left 
Palette" will display the Style Palette if it is hidden. 
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8. PRINT MENU 

Note: Print menu commands that behave in the same manner for all IRIS 
Intermedia applications are not described below. For an explanation of the "Page 
S t II "P . t " "P . t 0 " "H d' " "M . " "St t p N b " e up ... , nn ... , nn ne, ea ings, argins ... , ar age um er ... , 
"Top to Bottom," "Print Page Numbers," "Include Frame," "Show Breaks," "Show 
Page Numbers," and "Show Borders," see Chapter VI. IRIS Intermedia Reference 
Guide. 
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VIII. INTERDRAW REFERENCE GUIDE 

This reference guide contains a description of each menu command 
provided by the InterDraw application. For descriptions of the IRIS 
Intermedia system menu commands, see Chapter VI. IRIS Intermedia 
Reference Guide. 
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1. tl APPLE MENU 

Note: All Apple menu commands behave in the same manner for all IRIS 
Intermedia applications and are not described in this section. For an explanation of 
the "About IRIS Intermedia ... ," "Expand Window," "Redraw Screen," and 
"InterLex Dictionary" commands, see Chapter VI. IRIS lntermedia Reference 
Guide. 
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2. FILE MENU 

Note: File menu commands that behave in the same manner for all IRIS 
Intermedia applications are not described below. For an explanation of the "Open," 
"Close," "Close Definitions," "Save," "Save As ... ," "Revert," "Delete Document," 
"Close All Documents," and "Quit" commands, see Chapter VI. IRIS Intermedia 
Ref ere nee Guide. 

New ... 
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Selecting the "New" command opens a window containing all the currently 
available IRIS Intermedia tools, including an InterDraw application icon. When 
the InterDraw icon is selected and "Open" is chosen from the File menu, an 
"Untitled" InterDraw window opens. The lnterDraw window may be moved and 
resized like all other IRIS Intermedia windows. The blank portion of the window, 
called the drawing area, is for entry of graphics objects including text. The Tool 
Palette, in the Left Palette of the window, allows you to select the type of graphics 
objects to work with from among text, lines, rectangles, rounded rectangles, ovals, 
arcs, objects drawn freehand, and polygons. The Style Palette, in the Top Palette 
above the drawing area, allows you to choose line widths, line, fill and text 
background patterns, and placement of arrowheads on lines and arcs. 

=D New 

@ ~ ~ • ~ Web folder V81 - Ward 

Note: Pressing the Apple key and typing an "n" is an alternate way. 

RleMenu 7. lnterWord Reference Guide 



3. EDIT MENU 

Note: Edit menu commands that are not applicable or that behave in the same 
manner for all IRIS Intermedia applications are not described below. See Chapter 
VI. IRIS Intermedia Reference Guide for a description of the "Undo," "Redo," 
"Cut," "Copy," "Paste," "Clear," "Find," "Define," "Insert Before," "Insert After," 
"Duplicate," "Select All," and "Add Event" commands. 
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4. INTERMEDIA MENU 

Note: Intermedia menu commands that behave in the same manner for all IRIS 
Intermedia applications are not described below. For an explanation of the "Start 
Link," "Complete Link," "Unlink," "Create Block," "Unblock," "Show Block Extent," 
"User Properties ... ," "Document Properties ... ," "Block Properties ... ," "Link 
Properties ... ," "View Specs ... " and "Follow" commands, see Chapter VI. IRIS 
Intermedia Reference Guide. 
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5. FONT MENU 

Note: Font menu commands that behave in the same manner for all IRIS 
Intermedia applications or are not applicable to InterDraw are not described below. 
For an explanation of the "Plain," "Bold," "Italic," "10-," "12-," "14-," "18 point," 
"Times," "Helvetica," "Left Sides," "Right Sides," "Centers," and "Full" commands, 
see Chapter VI. IRIS Intermedia Reference Guide. 
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6. ARRANGE MENU 

Send to Back 

Move to Front 

Swap Layer 

Group 

Ungroup 

Show/Hide 
Left Palette 

Show/Hide 
Top Palette 
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This command moves a selected object in a stack of objects to the bottom of the 
stack. You may select multiple objects to move using this command. If you do so, 
the selected objects will retain their original relationship to one another at the bottom of the stack. All of the objects beneath the selected object will move up one 
place in the stack, making this command useful for examining items in a stack one by one. 

This command moves a selected object in a stack of objects to the top of the stack so 
that it can be easily examined and worked on. You may select multiple objects to 
move using this command. If you do so, the selected objects will retain their 
original relationship to one another at the top of the stack. All of the objects 
originally on top of of the selected object in the stack will move down one. 

This command switches the positions of two selected objects in a stack of objects. 
For example, if you choose this command after selecting a rectangle on the bottom 
of the stack and an oval directly under the top object in the stack, the rectangle 
will move up to occupy the oval's position and the oval will go to the bottom of the 
stack. 

If more than one object is selected, the "Group" command in InterDraw groups the 
objects so that they will behave as a single object. Any objects in the selection that 
are already groups are imbedded in the new group so that no grouping information is lost. After grouping, the group is then selected (shown with handles 
placed in a rectangular region encompassing all the objects in the group). 

If the selection contains objects that have been grouped, the InterDraw command 
"Ungroup" separates the objects. All of the objects in the group will be individually 
selected (surrounded by handles). Any imbedded groups within the selection 
remain grouped. If you want to ungroup imbedded groups, you must select the 
remaining groups and use the "Ungroup" command again. 

If the Tool Palette is visible, you can hide it from view by selecting "Hide Left 
Palette." 

It is possible to obtain both constrained and unconstrained versions of many of the 
tools on the Tool Palette. See Chapter IV. Using InterDraw for more information. 

If the Style Palette is visible, you can hide it from view by selecting "Hide Top 
Palette." \Vhen the Style Palette is hidden, you can perform most editing 
commands on the document, but cannot work with line, fill or background 
patterns, line widths, or arrowheads. You can display the Style Palette if it is 
hidden by choosing "Show Top Palette" from the Arrange menu. 
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Allgh Left Sides This command aligns the left sides of two or more selected objects. The object 
selected first remains in its place, and the others will gravitate to it. 

Allgn Horizontal 
Centers This command aligns the horizontal centers of two or more selected objects. The 

horizontal centers of the selected objects are averaged to find the new horizontal 
center for selection, and the objects will gravitate to it. 

Align Right Sides This command aligns the right sides of two or more selected objects. The object 
selected first remains in its place, and the others will gravitate to it. 

Align Tops 

Align 

This command aligns the top sides of two or more selected objects. The object 
selected first remains in its place, and the others will gravitate to it. 

Vertical Centers This command aligns the vertical centers of two or more selected objects. The 
vertical centers of the selected objects are averaged to find the new vertical center 
for selection, and the objects will gravitate to it. 

Align Bottoms This command aligns the bottom sides of two or more selected objects. The object 
selected first remains in its place, and the others will gravitate to it. 
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7. PRINT MENU 

Note: Print menu commands that behave in the same manner for all IRIS 
Intermedia applications are not described below. For an explanation of the "Page 
S t II "P . t II "P . t 0 II "H d" II "M . " "St t p N b " e up ... , nn ... , nn ne, ea 1ngs, argins ... , ar age um er ... , 
"Top to Bottom," "Print Page Numbers," "Include Frame," "Show Breaks," "Show 
Page Numbers," and "Show Borders," see Chapter VI. IRIS Intermedia Reference 
Guide. 
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X. INTERVAL REFERENCE GUIDE 

This reference guide contains a description of each menu command 
provided by the InterVal application. For descriptions of the IRIS 
Intermedia system menu commands, see the Chapter VI. IRIS 
Intermedia Reference Guide. 
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1. 9 APPLE MENU 

Note: All Apple menu commands behave in the same manner for all IRIS 
Intermeclia applications and are not described in this section. For an explanation of 
the "About IRIS Intermedia ... ," "Expand Window," "Redraw Screen," and 
"InterLex Dictionary" commands, see Chapter VI. IRIS Intermedia Reference 
Guide. 
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2. FILE MENU 

Note: File menu commands that behave in the same manner for all IRIS 
Intermedia applications are not described below. For an explanation of the "Open," 
"Close," "Close Definitions," "Save," "Save As ... ," "Revert," "Delete Document," 
"Close All Documents," and "Quit" commands, see Chapter VI. IRIS Intermedia 
Reference Guide. 

New... Selecting the "New ... " command opens a window containing all the currently 
available IRIS Intermedia tools, including an InterVal application icon. When 
the InterVal icon is selected and "Open" is chosen from the File menu, an 
"Untitled" InterVal window will open. 
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ao New 

@ ~ • ~ ~ . 

Web Folder - Dra...., Word 

Note: Holding down the Apple key and typing an "n" is an alternate way of 
opening the New window. 
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3. EDIT MENU 

Note: Edit menu commands that are the same for all applications or that do not 
apply to InterVal are not described in this section. See Chapter VI. IRIS 
Intermedia Reference Guide for a description of the "Undo," "Redo," "Cut," "Copy," 
"Clear," "Find," "Define," "Duplicate," and "Select All" commands. 

Paste 

Insert Before 

Insert After 

The result of a "Paste" command depends on the current contents of the Clipboard 
and the timeline objects that are selected when the command is issued. 

If the Clipboard contains a timeline event and no event is currently selected, the 
event in the Clipboard is pasted at the year associated with the event before it was 
cut or copied. If there are already events at this date, the event in the Clipboard is 
placed at the end of the list of events. If the Clipboard contains a title and no event 
is currently selected, the title replaces the timeline's title. Pasting without 
selecting an event is provided so that you can select part or all of an existing 
timeline and paste it into another InterVal document, thereby making an exact 
copy of the original. 

If an event is currently selected, the contents of the Clipboard will be pasted after 
the selected event, at the same date. If more than one event is currently selected, 
the contents of the Clipboard will be pasted after the first event in the selection. 

If the timeline title or 
nothing is selected 
and the Clipboard 
contains material 
from an application 
other than Interval, a 
dialog box will appear 
asking at which date 
you want to place the 
event. 

Paste euent(s) at what year? 

[ OK ( Cancel J 

This InterVal command inserts pasted material at the same year as the selected 
event, but directly before it. 

This InterVal command inserts pasted material at the same year as the selected 
event, but directly after it. 
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Add Event. .. 
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The "Add Event ... " command opens a dialog box that allows you to enter a date 
and label to define a new event on the timeline. When the dialog is displayed, type 
the appropriate year in the "Add an event at what year?" box at the top of the 
dialog. Then click once in the "Label?" field to create an insertion point (or press 
the Tab key) and type in the desired label. Be sure that the label is comprised of 
fewer than eighty characters. Click on the "OK" button to close the dialog and dis­
play the event on the timeline. You must reopen the dialog each time you wish to 
add an event. 

Rdd en euent et whet year? 

Lebel? 

[ OK ] Cancel ) 

Note: Holding down the Apple key and typing an "e" is an alternate way of 
opening the "Add Event" dialog. 
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4. INTERMEDIA MENU 

Nate: Intermedia menu commands that behave in the same manner for all IRIS 
Intermedia applications are not described below. For an explanation of the "Start 
Link," "Complete Link," "Unlink," "Create Block," "Unblock," "Show Block Extent," 
"User Properties ... ," "Document Properties ... ," "Block Properties ... ," "Link 
Properties ... ," "View Specs ... " and "Follow" commands, see Chapter VI. IRIS 
Intermedia Reference Guide. 
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5. FONT MENU 

Note: Font menu commands that behave in the same manner for all IRIS 
Intermedia applications or are not applicable to InterVal are not described below. 
For an explanation of the "Plain," "Bold," "Italic," "10-," "12-," "14-," "18 point," 
"Times," "Helvetica," "Left Sides," "Right Sides," "Centers," and "Full" commands, 
see Chapter VI. IRIS Intermedia Reference Guide. 
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6. ARRANGE MENU 

Note: Arrange menu commands primarily apply to InterDraw documents, so most 
of the commands are not described below. For an explanation of "Send to Back," 
"Move to Front," "Swap Layers," "Group," "Ungroup," "Hide Top Palette," "Align 
Left Sides," "Align Horizontal Centers," "Align Right Sides," "Align Tops," "Align 
Vertical Centers," and "Align Bottoms," see Chapter VI. IRIS Intermedia 
Reference Guide. 

Show/Hide 
Left Palette If the Tool Palette is visible, you can hide it from view by selecting "Hide Left 

Palette." If the Tool Palette is hidden from view, choosing the "Show Left Palette" 
command will cause it to reappear. 
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7. PRINT MENU 

Note: Print menu commands that behave in the same manner for all IRIS 
Intermedia applications are not described below. For an explanation of the "Page 
S t " "P . t " "P . t 0 " "H d' " "M . " "St t P N b " e up ... , nn ... , nn ne, ea ings, argins ... , ar age um er ... , 
"Top to Bottom," "Print Page Numbers," "Include Frame," "Show Breaks," "Show 
Page Numbers," and "Show Borders," see Chapter VI. IRIS Intermedia Reference 
Guide. 
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Right Align button 130 
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in lnterWord documents 130 
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Application programs 
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lnterVal 1, 189-21 O 

Index 
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Bitmap images (See also lnterPix) 1, 143, 180-183 

Changing the background 183 
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Editing 73 
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Selecting 139, 185, 208 

in text 70 
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Editing 72 
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Blocks 
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in lnterWord 139-142 
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Boxes 

Current Style 126, 128 

Line Spacing 126 

Buttons 

c 

Increase line spacing 126 
Justify 126 

Double spacing 126 

One and a half spacing 126 
Single spacing 126 

Left Align 126 

More 126, 129 

Right Align 126 

Center Align button 126 
Center Tab well 126 

Centers command 223 
Change paragraph dialog box (See also More button) 
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Change style dialog box (See a/so More button) 129 
Changing 

All occurrences at once (See also Find 
command) 123 

Display characteristics 207 
Fill patterns 172 
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Ruler settings 133 
Styles 24-27 

Text in lnterWord documents 122 
Text patterns 173 

the background of a bitmap image 183 
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Choosing menu items 6 
Circles (See also constrained ovals)158 
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Clearing objects 36, 164, 201 
Clearing text in lnterWord 120 
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Close All Documents command 17, 43, 56, 67, 88, 215 
Closing all documents 43, 56 

Close Box 11, 17, 29, 43, 56, 116, 150, 195, 214 
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Closing a document 11, 116, 150, 195 
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Closing an lnterDraw document 150 
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Closing an lnterVal document 195 
Closing an lnterWord document 13, 116 
Closing windows 17, 56 
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Closing 

a web 19, 88 
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Text 153 

Copy command 36, 120, 165, 181, 201, 216, 234 
Copying bitmaps 181 

Copying graphics objects 36, 165 
Copying text 120 
Copying timeline objects 201 

Copying 

Bttmaps 181 

Graphics objects 36, 165 
Text 120 
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Create Block command 29, 69, 140, 186, 209, 218 
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a web 19-20, 67-68 
Blocks 140, 185, 209 

Groups 178 
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environment 18-43 
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in lnterDraw documents 167 
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Desktop 4 
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Block Properties 219 
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246, 256 
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from paths 85 
aweb20 

an lnterWord document 7, 20 
Documents from the Web View 32, 84, 85 
Existing lnterDraw documents 147 
Existing lnterVal documents 192 
Existing lnterWord documents 113 
Folders 5-6, 18 

Double-click option 18 
New lnterDraw documents 34, 147 
New lnterVal documents 192 
New lnterWord documents 114 
Newdocuments34, 114, 147, 192 
Windows 50 

Double-click option 50 
Orientation 100 
Other Group Members properties 90 
Oval tool 35, 158 

Selecting 158 
Overview of the IRIS lntermedia desktop 49 

p 
Page breaks 

Showing 105 
Page numbering 102 
Page Setup command 99, 226 

image size options i 00 

Orientation options 100 
Paper options 100 

Page Setup dialog box 99, 226 
Palettes 

Left 12, 24, 55, 151 
Ruler 12, 24, 27, 126-130 
Showing and hiding 24 
Style 

in lnterDraw 35, 151, 172-17 4, 176 
in lnterWord 12, 24, 27, 125, 131-138, 231 

Tool 151, 167, 168 
Top 12, 25, 55, 151 

Paste command 23, 37, 121, 165, 202, 216, 234, 257 
Pasting graphics objects 165 
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Pasting timeline objects 202 
Pasting text 121 

Paste Event dialog box 257 
Pasting graphics objects 37, 165 
Pasting text 23, 121 
Pasting timeline objects 202 
Paths 82-85 

Opening a document from 84-85 
Plain command 223 
Preparing image data dialog box 108 
Print command 106, 226, 241, 252, 262 

Pages options 107 
Paper Source options 106 

Print dialog box 106 
Print menu 4, 102, 106-108, 226-227, 241, 252, 262 
Print One command 226 
Print Page Numbers command 104, 227 
Printer Effects 99 
Printing and reformatting 99 
Printing and showing page numbers 104 
Printing folders, Web Views and documents 106 
Property list 89, 91 

Document properties 91 
Polygon tool 160 
Point size 168 

Q 
Quit command 17, 43, 56, 165, 202, 215 

Quitting IRIS lntermedia 17, 43, 56 
Quit dialog box 56 
Quitting IRIS lntermedia 17, 43, 56 

R 
Reactivate document marker 83 
Rectangle tool 156 

Selecting 156 
Redo command 39, 216 
Redraw Screen command 213 
Reorganizing text 22 
Repositioning and manipulating windows 7-11 
Repositioning objects 169, 179 
Reshaping events and titles 206 
Reshaping objects 170 
Resize Box 8, 52 
Resizing windows 8, 52 
Revert command 215 
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Right Align button 126 
Right Margin marker 126 
Right Sides command 223 
Rounded rectangle tool 156 

Selecting 156 
Rubberbanding 154 
Ruler (See a/so Top Palette)12, 24, 27, 126-130 

Alignment 130 
Center Align button 130 
Justify button 130 
Left Align button 130 
Right Align button 130 

Current Style Box 25-27, 128 
Definition 109, 125 
Diagram 126 
Indentation 127 
Line spacing 128 
Paragraph margins 126 
Showing and hiding 12 
Tabs 127 
Using 126 

Ruler components 
Center Align Button 126 
Center Tab well 126 
Current Style Box 25-27, 126 
Decimal Tab well 126 
Decrease Line Spacing button 126 
Increase Line Spacing Button 126 
Indentation marker 126 
Justify button 126 
Left Align Button 126 
Left Margin marker 126 
Left Tab well 126 
More button 126 
Right Align Button 126 
Right Margin marker 126 
RightTabwell 126 

Ruler diagram 126 

s 
SaveAscommand 115, 194,215 
Save As dialog box 115, 149, 194, 215 

Saving a copy of the current document 115, 149, 
194 

Save command 39, 41, 87, 115, 148, 149, 193, 215 
Saving the current document 115, 148, 193 

Save dialog box 39 
Saving 

a copy of the current document 115, 149, 194 
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a graphics document 148 
a web 41, 42, 86-87 
an lnterDraw document 148 
an Interval document 193 
an lnterWord document 115 
and naming a new document 39 
Links 41 
the current document 115, 148, 193 

Scope line 82 
Scroll Bar 9, 14, 53 
Scrolling 9, 53-54 

Down Scroll Arrow 9, 20, 53 
Scroll Box 9, 53 
Up Scroll Arrow 9, 53 
Using the Scroll Bar 9, 53 

Send to Back command 224, 250 
Select All command 217 
Selecting 

a single object 162 
a whole word 118 
an insertion point 152 
Block markers 70, 139, 185, 208, 139 
Graphics objects 36-37, 162 
Highlight handles 170, 178 200 
Icons 5 
Link Markers 14 
Menu items 12 
Multiple block markers in graphics 71 
Multiple objects 162, 163, 199 
Single objects 162, 198 
Text22, 118 
the arc tool 159 
the freehand tool 160 
the line tool 154 
the oval tool 158 
the polygon tool 160 
the rectangle tool 156 
the rounded rectangle tool 156 
the text tool 152 
Timeline objects 198 

Selection 118 
Bounding box 36 
by dragging 22, 118 
Definition 118 
Description 5 
Extending 119, 162-163 

with a bounding box 163 
with the Shift key 162 

Handles 28 
Highlighting text 21 
Highlighting menu items 6 
Making an insertion point 22 
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Selecting icons 6 

Shortening 119 

Text21 

Send to Back command 169, 170 

Setting an insertion point 117 

Setting block properties 32-33 

Setting view specifications 34 

Shortening the selection 119 

Show Block Extent command 142, 219 

Show Borders command 105, 227 

Show Breaks command 227 

Show Left Palette command 24, 55, 131, 151, 203, 204 

Show Page Numbers command 104, 227 

Show Top Palette command 12, 25, 125-126, 131, 151, 

250 

Show/Hide Controls command 225 

Showing 

Left palette 151 

Top Palette 151 

Showing and hiding the Palettes 12, 24, 55, 125-126 

Showing and printing page numbers 104 

Showing borders and page breaks 105 

Showing the Left Palette 12, 24, 125-126 

Showing the Top Palette 12, 24, 125-126 

Shrinking objects 170 

Squares (See also Constrained rectangles)157 
Start Link command 75, 141, 186, 187, 209, 210, 218 

Start Page Number command 102, 227 

Start Page Number dialog box 102, 227 

Starting links 28-29, 39, 141, 186, 209 

Starting the tutorial 4, 18-19 

Starting up the system 4 

Style list (See also Left Palette)12, 24, 27, 131-138 

Buttons 

Apply 231 

New231 

Definition 125 

Showing and hiding 12 

Style Palette (See also Top Palette) 35, 131-138, 173, 

174, 176 

Fill box 173 

Fill styles 38 

Line box 175 

Line widths 37 

N box 175 
Using 172 

Styles 

Applying 135-138 

to existing entities 138 

to new entities 137 

to new paragraphs 135 

Changing 24, 27 

Index 

Creating new 131-132 

Definition 109, 125 

Editing existing 132-133 

System 

Starting up 4 

exiting 17, 43 

Swap layer command 169, 170, 224, 250 

T 
Tabs 127 

Text 

Adding to lnterDraw documents 167 

Adding to lnterVal documents 203 

Adding to lnterWord documents 11 i 
Clearing 120 

Copying 120 

Cutting 23, 120 

Deleting 22, 120, 167, 200 

by cutting 119 

Deselecting 119 

Editing an lnterWord document 20, 27, 117, 124 

Editing titles and events 204 

Entering 117 

Finding and changing in lnterWord 122 

Highlighted, description 21 

in lnterDraw documents 152 

Pasting 24, 121 

Reorganizing 22 

Selecting 21-22, 118 

Text Background box 173, 17 4 

Texttool38, 152, 153,204 

Constrained text 

Dragging to create a text bracket 153 

Selecting an insertion point with 152 

Title bar 8, 50, 86, 115, 194 

Timeline objects 

Definition 198 

Timelines (See also lnterVal)1 

Adding events to 30 

Editing and manipulating 196-207 

Times, Helvetica command 223 

Tool Palette (See also Left Palette)35, 38, 55 

Arc tool 159 

Arrow Tool 36, 162, 200 

Circle tool (See also constrained ovals) 158 

Constrained lines 155 

Constrained ovals 158 

Constrained rectangles 157 

Constrained rounded rectangles 157 
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Constrained tools 152 

Freehand tool 160 

Line Tool 37, 154 

Oval Tool 35, 158 

Polygon tool 160 

Rectangle tool 156 

Rounded rectangle tool 156 

Selecting from the 152, 154, 155, 160 

Square tool (See a/so constrained rectangles) 

156 
T icon 167 

Texttool38, 152, 153,204 

Working with the 151 

Tools 

Text 166, 167 

Top Palette (See a/so Ruler)12, 24 

Top to Bottom 103, 227 

Side To Side 103 

Transition markers 69 

Follow 83 

Open 83 

Reactivate 83 

Type Style 168 

u 
Unactivated items 

Definition 4 

Unblock command 74, 218 

Undo command 39, 120, 164, 177, 216 

undoing actions 39 

Ungroup command 179, 224, 250 

Ungrouping objects 179 

Unlink command 80, 218 

User and document properties 89-98 

User properties (See also document properties) 89 

Definition 89 

User Properties command 90 

Group Information 89 

User Properties sheet 89 

User Properties dialog box 89, 219 

Using a web view 82 

Using the Member of Groups and Other Group 

Members properties 90 

Using the Ruler 126-130 

Using the Scroll Box 9, 53 
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v 
Viewing Specifications 

Fast option 34 

Setting 34 

Verbose option 34 

View Specs command 34, 80, 221 

Dialog box 34 

Viewing Specifications dialog box 34, 80, 221 

w 
Working with the Tool Palette 151-161 

Web View window 14, 19, 20, 32, 40, 41, 43, 66, 68 

Closing the Web View 43 

Definition 82 

Link lines 32, 41 

Opening documents from the 32 

Printing 106, 108 

Saving the Web View 43 

Scope Lines, Paths and Maps 82 

Transition markers 

Follow 83 

Open 83 

Reactivate 83 

Webs 1, 10, 12, 17, 66-88 

Closing 17, 88 

Creating 19-20, 67-68 

Definition 19, 49, 66 

Documents 

Opening from Maps 84-85 

Opening from Paths 84-85 

Icon 6, 68 

Maps 66 

Opening a document from 84-85 

Following links from 85 

Opening 12, 20, 68 

Double-click option 20 

Documents from Maps 84-85 

Documents from Paths 84-85 

Paths 66, 83 

Opening a document from 84-85 

Saving 42, 86-87 

Selecting a web icon 12 

Web View window 14, 19, 66, 68 

Using 82 

Window Diagram 8, 50 

Windows 4, 1 O, 50-56 

Activating 12, 15, 20, 30, 32, 41 
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Close Box 11, 50 

Closing a document 11 

Closing and quitting IRIS lntermedia 56 
Closing one at a time 56 
Definition 49, 50 

Folders 7 
Manipulating 7-11 

Moving 8, 50-51 

New68 

Opening 50 

Resize Box 8, 50, 52 

Resizing 8, 52 

Scroll Bar 9, 50, 53 

Scrolling 9, 20 

Title Bar 8, 50 

Web View 14, 19, 66, 68 

Window diagram 8, 50 

*This Index was compiled with contributions by 

Lelia DeAndrade, Sarah Arndt and Bruce Eimon. 
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